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Avant-propos

Ce manuel a été créé par Faxitron Bioptics LLC, une société de Hologic® Inc. Il est destiné a guider I'utilisateur sur la fagon
de configurer, d’installer et d'utiliser le matériel Faxitron Path+ et le systéme logiciel Vision, tous deux développés par
Faxitron Bioptics LLC.

Faxitron Path+ était auparavant connu sous le nom de PathVisionXL.

L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Veuillez consulter les procédures de
configuration requises dans la Section 2 de ce manuel avant de continuer.

Utilisation prévue

Le Faxitron Path+ est un systeme de radiographie monté dans une armoire, utilisé pour fournir des images sur film et/ou
des images radiographiques numériques d’échantillons provenant de diverses régions anatomiques afin de vérifier
rapidement que le tissu correct a été excisé durant la biopsie. La possibilité de procéder a cette vérification directement dans
la méme piéce ou a proximité de celle ou la procédure est effectuée accélére le déroulement des opérations et réduit ainsi la
durée nécessaire a I'examen du patient. La radiographie d’échantillons peut potentiellement limiter le nombre de rappels de
patients.

v'Utilisation sur ordonnance (Partie 21 CFR 801, sous-partie D).
Mise en garde : Les lois fédérales américaines limitent la vente de ce dispositif par un médecin ou sous prescription

médicale.

Le systéme peut fonctionner comme un dispositif autonome. Si le dispositif est connecté a un réseau, il est essentiel de
mettre en ceuvre des mesures visant a réduire le risque pour les patients en diminuant la probabilité que les fonctionnalités
dudit dispositif soient intentionnellement ou non compromises par une cybersécurité inadéquate.
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Ce manuel a été créé par Faxitron Bioptics LLC, une société de Hologic. Il est destiné a
guider l'utilisateur sur la fagon de configurer, d’installer et d’'utiliser le matériel Faxitron Path+
et le logiciel Vision, tous deux développés par Faxitron Bioptics LLC.

L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Au minimum,
veuillez revoir les procédures de configuration et de sécurité requises dans ce manuel avant
d’essayer de faire fonctionner le systéme.

Merci de la part de nous tous a Hologic.

Informations complémentaires

Pour une assistance technique complémentaire, contactez :

d EC |REP

Faxitron Bioptics LLC (une société de Hologic) Représentant européen agréé

3440 E. Britannia Dr. Suite# 150 Hologic BVBA
Tucson, AZ 85706 Da Vincilaan 5

(520) 399-8180 1930 Zaventem

(520) 514-8182 Fax Belgique
www.faxitron.com Tél.: +322 711 46 80

Fax : +322 725 20 87

Les symboles suivants sont utilisés dans ce manuel et dans le systéme d’aide en ligne :

Avertit le lecteur d'un risque d’électrocution s'il ignore I'avertissement et utilise
délibérément des outils spécialisés pour ouvrir une armoire électrique scellée et
manipuler son contenu. Remarque : Aucun outil n’est fourni.

Avertit le lecteur d’'une situation dangereuse. Ce symbole est généralement
accompagné d'un symbole plus spécifique et d'instructions appropriées
concernant la nature du danger, l'issue prévisible du danger et les informations
permettant d’éviter le danger.

Incite le lecteur a faire preuve de prudence lorsqu’il souléve du matériel lourd
afin d’éviter les blessures corporelles et les dommages matériels.

Avertit le lecteur qu’'un rayonnement ionisé est émis dans la zone marquée
lorsque le faisceau de rayons X est activé. Le Faxitron Path+ est doté de
dispositifs de verrouillage de sécurité pour empécher 'accés a la zone marquée
pendant que le faisceau de rayons X est activé.

Avertit le lecteur qu’il doit utiliser une protection appropriée (comme des gants
chirurgicaux ou un récipient pour échantillon approuvé) pour éviter I'exposition
a des matiéres potentiellement infectieuses comme les échantillons de tissus
des patients.

> kDD

Introduction

Symboles
d’avertissement et
de mise en garde
de ce manuel
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I SECTION
Faxitron" Path ntrocucion
Specimen Radiography System et symboles
1.1.1
Symbole Description Symboles

« MARCHE » pour une partie de 'appareil

Borne d’égalisation de potentiel

Eliminez le matériel électronique et électrique
séparément des déchets normaux. Renvoyez le
matériel hors service a Hologic ou contactez votre
représentant du service a la clientele

Fabricant

Date de fabrication

Mise en garde — Rayonnement (production de
rayons X)

Mise en garde — Matiéres potentiellement
infectieuses

Avertissement Electricité

Mise en garde

Suivez ou consultez le mode d’emploi

o~
o~
°
<

Nt

Ce systeme transmet de 1'énergie RF
(radiofréquence) et des rayonnements
non ionisants

Numéro de catalogue

e | &

Numeéro de série

d’avertissement
et de mise en
garde sur les
étiquettes
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Etiquette A — Versions standard et canadienne

| O | Etiquettes

Figure 1.2.1
X-Rays produced when energized. X-Rays produced when energized. ot} ), .
Do not insert any part of the body oy Do not insert any part of the body Ethuett,es d ?Vemssement
when energized - X-Ray hazard. m when energized - X-Ray hazard. et de sécurité
LES rayons-x ont produit quand oy LES rayons-x ont produit quand
stimule. stimule.
Ne pas faire d’insertion n'importe Ne pas faire d’insertion n’importe
quelle partie du corps quand stimule mca‘“‘!l"‘)’""':";s":s X quelle partie du corps quand stimule
- le danger d’eviter. PN T120 . UNAUTHORIZED USE PROHIBITED - le danger d’eviter. o "

A1 FRONT OF UNIT | | /A2 FRONT OF UNIT - CANADA

Etiquette C

/A CAUTION

Specimens are potentially infectious.
Use proper care when handling.

Les spécimens sont potentiellement contagileux.

Utiliser le soin correct en contrblant. ]

| C SPECIMEN WARNING LABEL

Etiquette D — Version standard et canadienne

KEEP DOOR THIS DEVICE PRODUCES XRAYS WHEN ENERGIZED

(on DRAWER) This instrument incorporates complete built-in lead and is a p!
as defined in n.B.S handbook 114 * standard for installation using non-medical
Ing
ALL TIMES energies up to 10 mev”. The shielding reduces external radiation to less than 0.5 mr/hr at 2"

EXCEPT DURING om ey :
This device should be operated only by responsible ir d in both
EE;ES'B‘SAD'NG safety and in the et forth in the manual,

BN 7120-6300-D1

D1 DOOR LABEL - KEEP DOOR CLOSED

KEEP DOOR THIS DEVICE PRODUCES XRAYS WHEN ENERGIZED
(OR DRAWER) This instrument incorporates complete built-in lead shielding and is a ve i i

CLOSED AT as defined in n.B.S handbook 114 “general safety standard for installation using non-medical
ALL TIMES ay energies up to 10 mev”. The shielding reduces external radiation to less than 0.5 mr/hr at 2"

EXCEPT DURING o
. This device should be operated only by responsible
BRIEF LOADING safety and in the operati forthinthe

PERIODS UNATHORLZSD USE PROMEBITED

D2 DOOR LABEL - KEEP DOOR CLOSED - CANADA
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Etiquette F 1.2.0
Etiquettes
(suite)
WARNING
For continued protection against risk of fire, replace only
with same type and rating of fuse
T5A-250V Figure 1.2.1
Pour assurer une protection continue le risque d’incendie, Ettlguett’es qf"emsseme”t
utilises uniquement un fusible de rechange de memes et ae securite

caracteristiques nominales.

P/N 7120-6300-K

F POWER FUSE WARNING LABEL

Etiquette G

WARNING

Safety
Interlock

Do not
tamper with
this interlock.

Radiation hazard
could result if
interlock is
not operating
correctly.

ATTENTION

De Verrouillage
De Sécurité

Ne pas modifier
ce verrouillage.
Risque d'irradiation
pourrait se
produire si de
vermrouillage ne
fonctionne pas
correctement.

PIN7120-6302H

G INTERLOCK WARNIN

Etiquette H
CAUTION: No operator ATTENTION : Pas de piéces
serviceable parts inside. réparable par l'utilisateur.
Refer servicing to Confiez I'entretien a
qualified personnel. un personnel qualifié.

P/N7120-6300-0

H NosERviCING
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1.2.0
Etiquettes
(suite)

Etiquette de code-barres, d’identification et de conformité

Figure 1.2.1
Etiquettes d’avertissement
et de sécurité

Remarque : Le code-barres est une norme GS1-128 et est enregistré dans la base de
données Global Unique Device Identification Database (GUDID) gérée par la FDA.
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- 1.2.0

Emplacements des étiquettes Etiquettes

(suite)

s c:q(ﬂ“ . Figure 1.2.2
Alimentation . o % gfl'%JF‘ftte A Emplacements des étiquettes
Rayons X activés o & - MARCHE/ARRET
=
N M
Etiquette D

(intérieur de la porte)

Etiquette G
(intérieur de la porte)

Etiquette C
(sol de la chambre)

Etiquette de conformité
et d’identification
(sur le cété)

crovetie A ™ s |
q ¥ TT00000NO0E0D DDORUOEDDEDRLDD
H e .0 H
Etiquette de
conformité et
d’identification B .
| e
Etiquette F — .
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Avertissements

¢ Veuillez lire attentivement les instructions avant d'utiliser le systéme.
o N'utilisez pas le systtme d’une maniére autre que l'utilisation prévue, comme décrit dans ce
manuel. En cas de doute, contactez Hologic ou votre distributeur agréé.

e Tous les cordons d’alimentation ne sont pas prévus pour la méme puissance. N'utilisez pas
d’autre cordon d’alimentation avec ce systéeme que celui fourni. N'utilisez pas le cordon

d’alimentation de ce systéme sur un autre équipement.
o Ce systéme a été testé conformément aux normes internationales les plus exigeantes ; toutefois,
il est recommandé de contacter les autorités nationales en ce qui concerne les exigences
opérationnelles locales.

e Ce systéme n’est pas destiné a une utilisation publique. Il doit étre situé dans une zone ou le

grand public ne peut pas accéder au systeme sans la présence d’'un opérateur.

Précautions générales

Les précautions suivantes doivent étre prises pour éviter dendommager votre systeme Faxitron Path+ :

¢ Ne connectez ou déconnectez jamais les cables de communication et/ou d’alimentation lorsque

Précautions et
avertissements
relatifs au
systéme

L\
A\

le systéme de détection est sous tension. Des dommages au détecteur CMOS ou a I'électronique
peuvent survenir si les cables sont connectés/déconnectés alors que I'appareil est sous tension.
¢ Le systeme de détection est fragile et des précautions doivent étre prises pour ne pas 'endommager.
Le systeme de détection ne doit jamais étre malmené, heurté, cogné ou laissé tomber.
e Le systeme Faxitron Path+ dispose d'un mode d’étalonnage. L’étalonnage doit étre effectué
quotidiennement pour assurer le bon fonctionnement du systéme. Veuillez vous reporter a la
procédure d’étalonnage.

e Mise en garde : L'utilisation de commandes ou de réglages pour effectuer des procédures autres
que celles spécifiées dans le présent document peut entrainer une exposition a un rayonnement

dangereux.

Connexions interopérables
Le Faxitron Path+ peut fonctionner comme un dispositif autonome sans aucune entrée ou sortie
vers d’autres dispositifs. Les images peuvent étre capturées, stockées et examinées directement

sur le systéme.

A\

Toutefois, le systéme est livré avec plusieurs interfaces. La principale est la connexion réseau qui
permet au systeme d’étre connecté a un systéme d’archivage et de transmission d'images (PACS,
Picture Archiving and Communication System). Les images peuvent ensuite étre transmises au
format DICOM du dispositif directement au réseau de I'établissement via notre logiciel. Voir Section 6
pour plus de détails sur la version DICOM. Seuls des employés de Hologic ou le personnel

informatique qualifié de I'établissement de I'utilisateur doivent configurer cette communication.

Les connexions du systéme et leur utilisation prévue sont indiquées ci-dessous. Aucun autre type

de dispositif ne doit étre connecté au Faxitron Path+ sans I'approbation de Hologic.

A\

Raccordement

Usage

Type de dispositif

Utilisateur prévu

Port Ethernet a
I'arriére

Pour stocker des images radiographiques
sur un réseau de stockage de données.

PACS ou stockage
en réseau

Configuré par le personnel de Hologic
ou du service informatique de
I'établissement. Utilisé par les cliniciens.

Port Ethernet a
I'arriére

Pour permettre une connexion a distance de
I'équipe d’entretien de Hologic, a des fins de
diagnostic et de réparation du systéme.

Connexion internet
en réseau

Personnel informatique de Hologic ou
de I'établissement, sous la direction de
Hologic uniquement.

imprimante standard compatible Windows.

Port USB sur Pour transférer des images a partir du Périphérique de Cliniciens ou personnel du service
le moniteur dispositif. Il ne doit étre utilisé que si le stockage USB informatique ayant un acceés autorisé
PACS ou le réseau n’est pas disponible. (clé USB) au systeme.
Port USB sur Pour I'entretien et la maintenance du Périphérique de Personnel de Hologic ou du service
le moniteur systéme. Par exemple, des fichiers copiés stockage USB informatique de I'établissement.
vers et depuis I'ordinateur pour les mises a | (clé USB)
jour de logiciels ou pour exporter des
fichiers journaux.
Port USB a Pour permettre la connexion d'une Imprimante Cliniciens ou personnel du service
I'arriere imprimante. Le logiciel Vision permet de DICOM ou informatique de I'établissement.
connecter une imprimante DICOM ou une Windows
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Cybersécurité
La sécurité des dispositifs est une responsabilité partagée entre Hologic et les établissements

de santé. Le fait de ne pas assurer la cybersécurité peut entrainer une détérioration des Précautions et

fonctionnalités du dispositif, la perte de disponibilité ou d’intégrité des données (médicales ou avertissements
personnelles) ou I'exposition d’autres dispositifs ou réseaux connectés a des menaces de sécurité. relatifs au
Hologic effectue un ensemble de contréles de cybersécurité pour garantir la cybersécurité de ses .

unités et pour assurer leur fonctionnalité et leur sécurité. systeme

Toutes nos unités utilisent le systéme d’exploitation standard Windows. Lors de l'installation, nous
recommandons a I'établissement de mettre en place toutes les mesures de sécurité nécessaires
définies par leurs propres exigences internes, comme ils le feraient avec tout autre PC connecté
au réseau.
L’établissement peut configurer le systéme d’exploitation Windows avec tous les protocoles de
réseau et les autorisations nécessaires. Par exemple, ils peuvent ajouter :

. ID utilisateur et mots de passe,

»  Autorisation par couches avec authentification appropriée,

. Restrictions sur les installations de logiciels,

»  Exigences relatives au contenu de confiance, y compris la vérification de la signature du code,

»  Configurer les mises a jour de Windows, y compris les versions de sécurité.
De plus, notre logiciel d'imagerie (Vision) peut étre protégé par un mot de passe afin que certains
utilisateurs puissent accéder au systeme d’exploitation sans pouvoir ouvrir le logiciel Vision.
L’unité est livrée avec une clé physique qui permet d’activer le systéme de radiographie. Cela
permet au systéme d’étre verrouillé, de sorte que méme si I'on accede au logiciel, aucune
radiographie ne peut étre lancée.

Cette unité est congue pour étre utilisée soit comme une unité autonome, soit pour étre connectée
au PACS interne de I'établissement ou a un autre réseau en boucle fermée. Elle n’est pas destinée
a étre connectée a Internet, a moins que (a) I'établissement regoive des instructions spécifiques de
la part de Hologic, et (b) que I'établissement prenne des précautions adéquates pour assurer sa
cybersécurité face aux menaces liées a sa connexion a Internet.

Hologic développera des mises a jour ou des correctifs pour le logiciel afin de continuer a assurer
la sécurité du produit, selon les besoins tout au long du cycle de vie de 'unité.

Des mesures de sécurité supplémentaires, y compris le cryptage, peuvent étre mises en ceuvre et
Hologic peut travailler avec le service informatique des établissements afin de réduire tout risque
pour les patients suite a une faille de cybersécurité.

Réglages réseaulutilisateur
Le détecteur du Faxitron Path+ utilise une connexion Ethernet (réseau) pour communiquer. L’ajout

d'utilisateurs ou la configuration d’une sécurité réseau supplémentaire peut empécher le détecteur de
communiquer avec le logiciel. Configurez les utilisateurs supplémentaires avec des droits
d’administration locaux pour assurer le bon fonctionnement du logiciel. Travaillez avec I'équipe
Faxitron/Hologic pendant l'installation pour vous assurer que le systéme est configuré correctement.

Nettoyage .
Chambre interne A&
Les échantillons contenant des échantillons biologiques peuvent abriter des agents infectieux dangereux

pour votre santé. Suivez les procédures de biosécurité appropriées : portez des gants lors de la
manipulation des échantillons de tissus ou de tout matériau avec lequel ils sont entrés en contact.

Essuyez régulierement I'intérieur de I'armoire avec de I'alcool isopropylique a 70-90 % ou avec de
I’hypochlorite de sodium dilué (5,25-6,15 % d’eau de Javel domestique diluée a 1:500 fournit la
concentration appropriée). Veillez a ce que la zone de I'échantillon, indiquée sur le sol de la
chambre, soit nettoyée a fond.

Chambre externe

Essuyez régulierement les surfaces externes avec de I'eau et du savon doux.

Ne trempez pas ou n’inondez pas les surfaces et n'utilisez pas d’abrasifs qui pourraient rayer les
surfaces. Ne laissez pas I'humidité entrer en contact avec les composants électriques du systéme.

Testez les produits de nettoyage sur une petite zone non visible des capots en plastique et en
métal pour vérifier qu’ils n"'endommagent pas le revétement.
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Le Faxitron Path+ doit étre configuré par un représentant autorisé de Hologic. Contactez Hologic 2.2 )

au numéro de téléphone +1 520-399-8180 pour confirmer que le systéme a été livré et pour fixer . .

une date d’installation et de configuration du systéme. Conflgu‘ratlon
du systéme

Faxitron Path+
Inspection de la caisse

Le systeme Faxitron Path+ est livré dans une grande caisse en bois. Demandez a l'agent de
transport de déposer les caisses dans une zone a I'abri du vol, des dommages et des conditions
environnementales extrémes, jusqu’a ce que le représentant autorisé puisse installer le systeme.

Vérifiez la caisse a la recherche d’éventuels dommages. Si elle semble endommagée, contactez
Hologic au +1 520-399-8180 ou votre représentant local.

La caisse fait environ 6 pieds (1,80 m) de haut. Elle contient I'unité pour analyser les échantillons,
I'écran d’affichage, I'ordinateur et les manuels du systéme.

Levage et transport de la caisse

Mise en garde: La caisse pése environ 1600 livres (725 kg). Le systéme emballé doit étre
maintenu en position verticale, comme indiqué sur les caisses d’expédition.

Déballage et assemblage du systéme

Le systéme Faxitron Path+ sera déballé et assemblé sur place par un représentant autorisé de
Hologic. Veuillez contacter Hologic au 520-399-8180 ou votre représentant local a la livraison de
votre systeme pour planifier sa configuration.

Pour retirer le systéeme de la caisse, un chariot élévateur a fourche adapté sera nécessaire pour
soulever la charge.

Vérifications de la sécurité et contréle des rayonnements

Pendant l'installation, des vérifications de sécurité et un contréle des rayonnements doivent étre
effectués, conformément a la procédure décrite a la Section 8, Calendrier de maintenance.

Exigences relatives a I’emplacement et au batiment

Le systeme Faxitron Path+ est doté d’une ventilation et le connecteur d’entrée d’alimentation se
trouve a I'arriére de I'armoire. Laissez au moins 6 po (15 cm) d’espace libre derriére I'unité une fois
installée pour permettre a l'air de circuler et pour permettre a [l'utilisateur d’y accéder pour
débrancher le cordon d’alimentation.

Assurez-vous que le plancher du batiment est congu pour supporter cette charge pendant toute la
durée de vie du produit. Vérifiez la réglementation locale en matiére de construction. Assurez-vous
également que le trajet vers la piéce ou le systéme sera installé peut supporter temporairement la
charge de I'armoire lors de son transport et de son installation.

Une fois en position, assurez-vous que les 4 patins des roulettes sont abaissés pour supporter le
poids du systeme. Le Faxitron Path+ est une grande armoire a rayons X blindée au plomb, qui
pése 1400 Ib (soit 635 kg). Les quatre patins des roulettes exerceront une force de 350 Ib (160 kg)
par roulette, ce qui équivaut a 900 kPa ou 130 Ib/po?.
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Conditions environnementales 2.3.0
En fonctionnement : SpeC|f|cat|ons
Température : 15,5 & 30 degrés C ou 60 a 86 degrés F.

Humidité relative : < 75 pour cent.

Stockage et transport :
Température : 0 a 45 degrés C ou 32 a 113 degrés F.
Humidité relative : < 75 pour cent.

Cet équipement a été congu pour les conditions suivantes :
+ Utilisation intérieure.

+ Altitude jusqu’a 2 000 métres.

» Degré de pollution 2.

« Surtension, catégorie Il.

RADIOPROTECTION

« Armoire blindée contre les rayonnements.

+ Porte de compartiment équipée d’'un double verrouillage de sécurité.

» Rayonnement : Moins de 0,1 mR/h & 5 cm (2 po) de la surface extérieure a kV maximum.

+ Certifié conforme aux normes établies par la US Food and Drug Administration, Center for
Devices and Radiological Health, (21 CFR-1020.40).

» Congu pour étre conforme aux normes établies par la CEI 61010.

TUBE A RAYONS X

Taille du point focal <15um

kV 20-100 kV

mA 1,0 mA max

Alimentation Isowatt limité a 11,5 W max
Epaisseur de la fenétre en béryllium 0,010" (254 um)
Divergence du faisceau de rayons X 40 deg. min.

Matériau de la cible Tungsténe (W)

COUVERTURE DU FAISCEAU (BC, BEAM COVERAGE) ET DISTANCE ENTRE
SOURCE ET OBJET (SOD, SOURCE TO OBJECT DISTANCE) POUR DIFFERENTES
POSITIONS DE TABLETTE/FACTEURS D’AGRANDISSEMENT

Position de la Diametre

tablette/Facteur nominal de BC

d’agrandissement cm (pouces) SOD cm (pouces)
10 6,1 (2,4") 9,2 (3,6")
8 76,2 (3,0") 11,5 (4,5")
6 10,2 (4,0") 15,3 (6,0")
5 12,2 (4,8") 18,3 (7,3")
4 15,3 (6,0") 22,9 (9,0")
3 20,3 (8,0") 30,5 (12,0
2 30,5 (12,0 45,8 (18,0")
1,5 41,6 (16,0") 61,0 (24,0")

1 (sol) 61,0 (24,0") 91,5 (36,0

AGRANDISSEMENT RADIOGRAPHIQUE : Jusqu’a 10 fois.
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CONTROLE DE L’EXPOSITION : Automatique ou manuel. 2.3.0

CYCLE D’UTILISATION DES RAYONS X : 50 %. (Sp(?tc:l;’lcatlons
sulte

INFORMATION SUR LE LASER : Produit laser de classe 1.
CEI 60825-1 Ed. 2.
Conforme aux normes 21 CFR 1040.10 et 1040.11, sauf pour
les déviations en vertu de I'Avis sur les produits laser numéro
50, daté du 24 juin 2007.

CARACTERISTIQUES ELECTRIQUES : 100-240 V CA, 50/60 Hz, 300 VA max.

PUISSANCE CALORIFIQUE MAXIMALE : 1 000 BTU/h.

DETECTEUR DE RAYONS X

Taille du détecteur : 43 cm x 43 cm (17" x 17").

Pixels de détection : 4 318 x 4 320 avec un pas de 100 um.

Panneau : Matrice active TFT/diodes en silicium amorphe sur substrat unique.
Résolution spatiale : 100 um au contact, (< 20 um avec agrandissement géométrique).
Limitation de résolution : 5 Ip/mm.

CAN : 16 bits.

Efficacité quantique de détection typique (DQE, Detective Quantum Efficiency) :
75 % (0 Ip/mm), 60 % (1 Ip/mm), 40 % (3 Ip/mm) pour RQAS5.

Fonction de transfert de modulation typique (MTF, Modulation Transfer Function) :
70 % (1 Ip/mm), 40 % (2 Ip/mm), 15 % (4 Ip/mm) pour RQA5.

Scintillateur : Csl(Tl) déposé directement.

DIMENSIONS EXTERIEURES (approximatives)

cm pouces
Taille 168 66
Largeur 137 54
Profondeur 81 32

DIMENSIONS INTERIEURES DU COMPARTIMENT (approximatives)

cm pouces
Taille 86 34
Largeur 63 25
Profondeur 63 25

POIDS (approximatif)

Avec ordinateur, moniteur, clavier et accessoires
kg Ibs

Net 635 1400

Expédition 725 1600
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Specimen Radiography System configuration
2.3.0
DIMENSIONS (approximatives) Spécifications
(suite)
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Etalonnage 3.1.0
Lors de la premiére installation, le systéeme doit atteindre la température ambiante de la Etalonnage
pieéce. Lors du démarrage initial du systéme, un étalonnage du systeme doit étre effectué ;

un étalonnage peut étre fait a tout moment s’il y a des problémes de qualité d'image.

Pour optimiser la qualit¢ de limage, le logiciel Vision et le matériel nécessitent un
étalonnage périodique. Cet étalonnage nécessite I'acquisition d’'images de référence. Ces
images peuvent étre regroupées en trois (3) catégories : images décalées, images sombres
et images du champ plat.

Figure 3.0.1
Mise en garde : Vérifiez que la chambre est Bouton Calibrate
vide avant de commencer I'étalonnage. (Etalonnage)
Pour démarrer manuellement I'étalonnage, Start Procedure
cliquez sur le bouton « Calibrate »
(Etalonnage).
Calibrate Review
L'utilisateur sera alors invité a lancer I'étalonnage.
Figure 3.0.2
Invite de démarrage
d’étalonnage
Start Calibration
Last Calibrated: 2| /31 14:41:53 Tue
ENSURE THE CHAMBER IS EMPTY BEFORE CALIBRATION
Calibration before beginning any procedure is recommended
Une fois ce bouton pressé, I'étalonnage est effectué.
Figure 3.0.3

Calibrating

‘i‘ SYSTEM IN CALIBRATION

Pendant I'étalonnage, le bouton « System in Calibration » (Systéme en cours d’étalonnage),
illustré ci-dessus, indique un « Exposure Status » (Etat d’exposition) accompagné du
message : « X-RAY IS ON, WAIT FOR COMPLETION » (RAYONS X ACTIVES, VEUILLEZ
ATTENDRE LA FIN DE LA PROCEDURE). L'utilisateur peut arréter I'exposition aux rayons
X en appuyant sur ce bouton a tout moment.

Une fois I'étalonnage terminé, le menu d’accueil s’affiche automatiquement.

Habituellement, le Faxitron Path+ s’étalonne autour de 30 kV au bout de 15 secondes pour
atteindre 8 000 ADU. Ceci varie d’'un systéme a l'autre.
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Démarrage rapide —
Fonctionnement
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Faxitron Path+
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SECTION

_ _ Démarrage
Specimen Radiography System rapid e
Avant de mettre le systéme sous tension, veuillez vous assurer que toutes les connexionsdes 4.1 .()

cablages sont sécurisées.

Ready L1

A\
Full Auto

Mode Magnifcation

\ Touche
Marche/

Arrét

Protocole applicable a la séquence de démarrage du systéme

Cette séquence de démarrage doit étre respectée pour assurer le bon fonctionnement du
systeme et la qualité de I'image :

Mise sous tension du systeme :

e Mettez sous tension le systéme Faxitron Path+ en mettant l'interrupteur d’alimentation
sur Marche. Le bouton d’alimentation est situé a I'arriere du systéme, a coété de la prise
du cordon d’alimentation. Faites basculer sur « 1 » pour mette en position « MARCHE »
et sur « 0 » pour mettre en position « ARRET ».

o Mettez le systeme Faxitron Path+ sur « MARCHE » en insérant la clé Faxitron Path+
dans linterrupteur a clé situé sur le panneau avant et en la tournant dans le sens des
aiguilles d’'une montre jusqu’a la position « 3 heures ». Remarque : la clé ne peut pas
étre retirée dans cette position.

o Allumez le moniteur s’il n'est pas déja allumé.

Démarrage du logiciel :

o Vérifiez qu'il N’y a rien dans la chambre a rayons X Faxitron Path+.

o Le logiciel Vision doit démarrer automatiquement lorsque le
systéme d’exploitation Windows a achevé son démarrage. Si le
logiciel ne démarre pas automatiquement, faites un double clic
sur l'icone Vision présente sur le bureau de Windows.

Etalonnage :

e Au premier démarrage de la journée, le logiciel devrait s’ouvrir sur la page d’étalonnage.

e Appuyez sur le bouton « Calibrate » (Etalonner) et patientez jusqu’a ce que le systéme
termine I'étalonnage.

Recommandations supplémentaires pour une qualité d’image cohérente

Laissez le systéme préchauffer pendant au moins une demi-heure avant I'étalonnage et
'acquisition d’images. Effectuez un étalonnage complet chaque jour avant la premiére
utilisation du systéme. Le systéme est configuré pour effectuer cet étalonnage lorsque vous
démarrez le logiciel Vision.

Démarrage rapide

Figure 4.1.1
Panneau avant du
Faxitron Path+

VAN

Figure 4.1.2
Icéne Vision sur le bureau

FAXITRON PATH+ MANUEL DE L’UTILISATEUR | HOLOGIC | REVISION 001

HOLOGIC s



Faxitron” Patht SECTION

Démarrage
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Procédures d’imagerie de base 41.0

Avertissement : Utilisez des contenants ou des gants agréés afin d’éviter tout contact avec Der.narrage raplde
des échantillons potentiellement dangereux. (suite)

Mise en garde : L'utilisation de commandes ou de réglages pour effectuer des procédures

autres que celles spécifiées dans le présent document peut entrainer une exposition a un
rayonnement dangereux.

Remarque : Pendant la configuration du détecteur et du logiciel, I'écran tactile de 'armoire a

rayons X affiche I'état en haut de I'écran. Par exemple : Etalonnage, Pause et Prét. f

Démarrage de la procédure

e  Surla page du menu d’accueil, sélectionnez le bouton Start Procedure (Procédure de
démarrage).

Figure 4.1.3
Ecran de démarrage (Accueil) du

Start Procedure programme Vision de Faxitron

Calibrate

2 14:41:53 Tue

> @, O
Review Help Shut Down

e | 'utilisateur aura le choix entre Select from Work List (Sélectionner dans la liste de
travail), Manual Entry (Saisie manuelle), Select from Database (Sélectionner dans la

base de données) ou Continue with current patient (Continuer avec le patient
actuel).

e  Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton Manual
Entry (Saisie manuelle).

Figure 4.1.4
Options de la procédure
de démarrage

Back

Select from Database E

Continue with current patient
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41.0

e La boite de dialogue Patient Information Editor (Editeur d’informations sur le patient)
s’ouvre. .
(suite)

HOLOGIC Figure 4.1.5

Ecran des données de
I'échantillon/du patient

Patient Name: LN cameraaxa MM N B00304

Patient ID: U N B00304

Accession #: UM B00304

Date of Birth: 2007/07/27

Gender: Female

Procedure Name:

Laterality:

*
-

Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

Start 2 New Patient or Procedure

Remarque : Les champs obligatoires sont indiqués par un astérisque blanc (*).
Les champs obligatoires par défaut sont : Patient Name (Nom du patient), Patient ID (ID du
patient), Accession Number (Numéro d’ordre) et Laterality (Latéralité).

e Saisissez tous les champs obligatoires. Le bouton Accept (Accepter) ne sera pas actif
si 'un des champs obligatoires manque. L'utilisateur peut remplir d’autres champs s'il le
souhaite.

Remarque : La date doit étre saisie sous la forme année, mois, jour (par exemple 1962/08/13).
En cas de saisie incorrecte, un message d’erreur s’affiche.

e  Sélectionnez Accept (Accepter) pour activer I'acquisition d’image.

Démarrage rapide
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Imagerie a Rayons X 4.1.0

e Placez le(s) échantillon(s) dans un récipient pour échantillon fourni par Faxitron Bioptics LLC Der_narrage raplde
ou par votre établissement et déposez-le(s) a I'intérieur de la chambre a rayons X Path+. La (suite)
zone d'imagerie est indiquée par un autocollant matérialisant son contour. (L’utilisateur peut
également placer I'échantillon et le récipient sur le plateau d’agrandissement fourni avec le
systéeme Path+.)

e Appuyez sur le bouton vert Start X-ray (Démarrer les rayons X) (soit dans le logiciel soit
en face avant de I'armoire a rayons-X) pour démarrer I'acquisition d'images/radiographies.

e Attendez que I'image s’affiche.

Remarque : Avec le mode Full Auto sélectionné, deux radiographies seront prises, la
premiere pour déterminer les meilleurs réglages et la seconde pour I'image elle-méme. Les
réglages utilisés pendant I'exposition (kV et durée) sont affichés sur I'écran LCD de
I'armoire.

Remarque : Une fois I'exposition achevée, le systeme peut acquérir une image « sombre »
pour éliminer le bruit de I'image. L’acquisition d’'une image sombre prend le méme temps
que I'exposition aux rayons X.

e L’image finale peut ensuite étre enregistrée dans le PACS en cliquant sur licone
d’enregistrement ci-dessous.
Remarque : Le logiciel Vision est configuré pour enregistrer automatiquement I'image dans
la base de données Faxitron sur le disque local de I'ordinateur du systeme.

HOLOGIC _ Figure 4.1.6

Ecran avec image

Pour plus d’informations sur le réglage des paramétres d’'image, les commandes de rayons X
et les options d’analyse et d’enregistrement, voir Section 5.
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Le Faxitron Path+ peut fonctionner sans ordinateur ou caméra numérique interne connecté(e).  4.2.0

Dans ce mode, le systéme peut obtenir des radiographies et des images capturées a partir
d’un film ou un systéme d’imagerie tiers.

Lorsque le systéme n’est pas équipé d’un détecteur numérique interne et d’'un PC, le panneau
avant affichera un X sur I'icbne en haut de I'écran et seul le mode manuel sera sélectionnable.

Ready n
Manual 1.0

Mode Magn'rfcation

4 s

O. O
- x.Fay
5.0

Time (secs)

Dans ce mode :
e  Placez un échantillon dans la chambre, sur le sol ou sur une tablette d’agrandissement.
e Réglez la tension en kV (20 — 100 kV) et la durée (1-60 secondes) souhaitées.
e Appuyez sur « X-Ray » (Rayons X).

Tournez linterrupteur a clé sur le panneau avant dans le sens inverse des aiguilles d’'une
montre jusqu’a la butée et, si nécessaire, vous pouvez retirer la clé. Attendez 30 secondes
pour vous assurer que l'ordinateur s’éteint complétement.

Remarque : N'essayez pas de remettre le systéme sous tension avant que I'ordinateur soit
complétement éteint.

Remarque : Il n’est pas nécessaire d’éteindre le moniteur car il passe automatiquement en
mode d’économie d’énergie.

Mode manuel

Figure 4.2.1
Ecran tactile

4.3.0
Arrét

Figure 4.3.1
Icéne du systeme d'arrét
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Fonctionnement du
logiciel Vision
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SECTION
Logiciel
Vision

Le logiciel Vision est un ensemble complet d’acquisition et de traitement d’images, congu
exclusivement pour fonctionner avec les générateurs de rayons X de Faxitron Bioptics (tels
que les systémes VersaVision, PathVision, CoreVision et BioVision.) En plus des fonctions
d’acquisition et de traitement, le logiciel offre un module de base de données étendue qui
permet a I'utilisateur de commander et de gérer 'archivage, le stockage, le classement et la
récupération des images. Le logiciel est également conforme a la norme DICOM (Digital
Imaging and Communications in Medicine), ce qui permet d’enregistrer et d’'imprimer les
images des patients au format DICOM 3.0.

Au démarrage, le logiciel signale qu'un étalonnage est nécessaire et propose soit de
démarrer I'étalonnage, soit de I'ignorer. L’étalonnage du systéme est requis au début de
chaque nouvelle journée d'utilisation du systéme, pour garantir la meilleure qualité d'image.

L’étalonnage peut également étre effectué a tout moment par I'utilisateur. Apres I'étalonnage,
le menu de démarrage principal s’affiche. C’est a partir de cet écran que la navigation vers
toutes les autres zones du logiciel s’effectue. Pour faciliter ['utilisation, des boutons
d’application sont disponibles, voir Figure 5.0.1. Ces boutons se trouvent au centre de
I'écran. Les descriptions et définitions des boutons sont présentées dans les sections
suivantes de ce manuel.

Start Procedure

Calibrate Review Shut Down

2 14:41:53 Tue

5.0.0
Apercu du
logiciel Vision

Figure 5.0.1
Logiciel Vision
Ecran de démarrage
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Logiciel
Specimen Radiography System Vision
Protocole de séquence 5.1.0
Démarrage

Cette séquence de démarrage doit étre respectée pour assurer le bon fonctionnement du
systeme et la qualité de I'image :

o Mettez le systéme Faxitron Path+ sous tension en tournant la clé située a I'avant de
I'appareil sur la position « MARCHE ».

¢ Allumez le moniteur si ce n’est pas déja fait.

e Laissez le systéeme préchauffer pendant au moins une demi-heure avant I'étalonnage et
I'acquisition d’'images.

e Depuis le bureau WINDOWS, double-cliquez sur I'icdne du logiciel Vision, si Vision n’est
pas déja actif.

e Pour les protocoles d’étalonnage, reportez-vous a la section « Apercu de I'étalonnage ».

Le logiciel Vision a été préinstallé sur I'ordinateur fourni avec votre propre systéme de
radiographie. Au cas ou le logiciel Vision ne serait pas réglé pour démarrer automatiquement,
I'utilisateur peut avoir besoin d’activer le logiciel Vision en double-cliquant avec le bouton
gauche de la souris sur I'icéne du logiciel Vision, située sur le bureau WINDOWS. Voir
Figure 5.1.1.

Pendant le chargement du logiciel Vision, une boite de dialogue apparait pour indiquer
I'initialisation du logiciel.

du logiciel

A\

Figure 5.1.1
Icbne du bureau du logiciel Vision

Il peut parfois étre souhaitable d’incorporer les caractéristiques d’atténuation des rayons X
d'un atténuateur uniforme dans les images d’étalonnage de référence en champ plat. Par
exemple, si tous les objets qui doivent étre balayés sont placés sur une mince plaque de
plastique, les caractéristiques d’atténuation des rayons X de la plaque seront observées
dans chaque image acquise. Dans ce cas, le fait de placer la plaque dans le faisceau de
rayons X pendant I'acquisition de I'image d’étalonnage de référence en champ plat pourrait
améliorer la qualité de I'image.

Remarque : Les différents générateurs de rayons X ont des paramétres légérement différents.

5.2.0
Etalonnage avancé
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Introduction a I’étalonnage 5.21
Apercu de

Pour optimiser la qualité de I'image, le logiciel Vision et le matériel nécessitent un Pétalonn
étalonnage périodique. Cet étalonnage nécessite I'acquisition dimages de etalo a,ge
référence. de la caméra

Lors de la mise en service initiale du systéme ou a n’importe quel moment souhaité
par l'utilisateur, un étalonnage du systéme peut étre demandé et effectué. Il est
recommandé d’effectuer les étalonnages suivants toutes les douze (12) heures.

Ces images d’étalonnage de référence sont utilisées pour étalonner une image
radiographique « brute » pixel par pixel, afin de générer une image « corrigée » pour
I'affichage. Les corrections d'image effectuées comprennent les corrections de gain,
de décalage et de linéarité.

Séquence d’étalonnage

Pour plus de commodité, le logiciel Vision combine les nombreuses étapes de
I’étalonnage en une étape unique.

Lorsqu’un systéme a rayons X Faxitron a été éteint pendant plus de six (6) heures,
le systtme demande automatiquement a étre réétalonné. Il est fortement
recommandé de réétalonner le systeme aprés une longue période d’inactivité ou
aprés un déplacement du systeme d’'une piéce a une autre, car les parametres de
température/humidité ambiante peuvent étre différents.

Pour étalonner le systéme a tout moment, cliquez sur le bouton Calibrate
(Etalonnage) sur I'écran de démarrage de Vision (écran principal) puis appuyez sur
« Start Calibration » (Démarrer I'étalonnage). La fonction « Skip » (Ignorer) peut étre Calibrate
utilisée pour ignorer les étalonnages si besoin avant de commencer I'étalonnage et
pendant I'étalonnage. Cependant, ceci pourrait déboucher sur une qualité d'image
inférieure a la norme. Voir Figure 5.2.1. La boite de dialogue affiche un message
d’état pendant I'étalonnage.

2007/07/31 14:41:53 Tue

Pendant I'étalonnage, des rayons X peuvent étre générés. Pendant la génération
des rayons X, un bouton « Stop X-Ray » (Arréter les rayons X) sera rendu visible
pour permettre a I'utilisateur d’arréter les rayons X par le biais du logiciel.

Start Calibration

Last Calibrated: 200 1 14:41:53 Tue

Figure 5.2.1

Boite de dialogue
d’étalonnage du décalage du
détecteur et du champ sombre

Calibration before beginning any procedure is recommended

Calibrating

.i‘ SYSTEM IN CALIBRATION
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Voici un résumé du protocole d’étalonnage avancé pour « Both » (Les deux) (Champ
plat et Image) : Apergu de

Placez l'atténuateur uniforme sur le détecteur. Toute la surface du détecteur doit étre
recouverte par I'atténuateur. Pour obtenir des résultats optimaux, I'atténuateur doit étre plus
grand que la zone d’imagerie du détecteur.

Depuis I'écran de démarrage du logiciel d'imagerie, appuyez sur 'icdne « » » en haut a droite
pour faire apparaitre le menu. Sélectionnez I'’élément du menu déroulant « Tools » (Outils)
dans le menu horizontal situé en haut de I'écran, puis passez de « Advanced Tools » (Outils
avancés) a « X-Ray Calibration/Exposure Setup » (Etalonnage des rayons X/Configuration
de I'exposition).

X-ray Generator and Exposure Settings 6

~ GEMERATOR SETTINGS — - EXPOSURE SETTINGS

K Current SET SetFor  ()¥gayCal FlatField) O Manuallmage @) Both
- — Test Exposure —User Timeda80U Target ———————
md, Current | 10000

Time[s] | 200 ‘ Select O Time  ©a0U ‘
Y 280 .

Ifrrap Cal aDLys 15326 Time [5] |4.?5 | ADU |BDDD.D |

r:ar;: e \ﬂ‘ [ Aequire l Estimate/Calculate

AUTOMATIC EXPOSURE CONTROL [OM THE FLY)

Magnification -| .0on
| AEC Mode far Image ON [TARGET=Image ADU)

- NUMBER DF CAL IMAGES ————— | AEC Mode for Flat-Field OM [TARGET =Flat-Field ADU]
seray Cal [Flat-Field) &
ray Cal [Flal Field) &werages Rl Ee e ached BB it eut bre ot stat
~ IMAGING MODE

EApply b anual Imaging Settings On Exit, Disengage Preshat

[ Accept Settings ] [ Cancel

REMARQUE : Les valeurs affichées dans I'écran d’exemple ci-dessus ne sont PAS
nécessairement les valeurs correctes pour votre type de générateur de rayons X.

 Sous « X-Ray Generator and Exposure Settings » (Générateur de rayons X et parametres
d’exposition), saisissez le réglage en kV du générateur dans le champ approprié.

« Définissez une valeur pour « Magnification » (Agrandissement) ou laissez le réglage par
défaut de un (1.0).

- Sélectionnez le bouton « Set for » (Régler pour) « Both » (Les deux) dans la boite de
dialogue.

- Laissez le réglage par défaut « user ADU target » (cible ADU utilisateur). L’exposition aux
rayons X sera terminée lorsque le détecteur aura accumulé un niveau de signal moyen
d’ADU acceptable pour votre générateur de rayons X.

« Conservez le temps d’exposition par défaut du test et cliquez sur le bouton « Acquire »
(Acquérir). Le systtme commencera automatiquement I'émission de rayons X et fera
I'acquisition d’'une image.

- Lorsque l'exposition aux rayons X est achevée, cliquez sur le bouton « Estimate/
Calculate » (Estimer/Calculer).

- Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]). Le systéme
calcule cette durée et le nombre est grisé.

I’étalonnage
de la caméra
(suie)

Figure 5.2.2
Boite de dialogue Générateur
de rayons X et exposition
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- Saisissez la valeur du temps d’exposition calculé de « Time [s] » (Durée [s]) dans la zone
de temps « Test Exposure » (Exposition test). Appuyez sur le bouton « Acquire » Aper d
(Acqueérir) pour lancer automatiquement les rayons X et obtenir une image. percu de

- Lorsque Il'exposition aux rayons X est terminée, cliquez sur le bouton
« Estimate/Calculate » (Estimer/Calculer).

- Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]).

- Saisissez a nouveau le temps d’exposition calculé dans le champ « Test Exposure »
(Exposition test).

« Cliquez sur le bouton « Accept Settings » (Accepter les parametres).

- Effectuez une procédure d’étalonnage standard, comme décrit dans la section « Apergu
de I'étalonnage de la caméra ».

Les utilisateurs expérimentés peuvent désirer régler les paramétres d’exposition « X-Ray Cal
(Flat-Field) » (Etalonnage des rayons X [champ plat]) et « Manual Image » (Image manuelle)
indépendamment ou « Both » (Les deux) (champ plat et image manuelle), comme décrit
précédemment. En sélectionnant la case « Flat Field » (Champ plat), le systéme détermine
le temps d’exposition optimal pour I'acquisition d’images en champ plat avec le niveau ADU
souhaité. En conséquence, la sélection de « Manual Image » (Image manuelle) déterminera
le temps d’exposition optimal pour le systéme avec un objet qui atténuera les rayons X. Pour
de meilleurs résultats, toute la zone d’imagerie du détecteur doit étre recouverte par I'objet.

Aprés avoir sélectionné « X-Ray Cal (Flat-Field) » (Etalonnage des rayons X [champ plat])
et « Manual Image » (Image manuelle) et que le niveau ADU a été réglé, sélectionnez le
bouton « Acquire » (Acquérir). Pour la sélection « Manual Image » (Image manuelle), il est
souhaitable que l'objet ou I'atténuateur de rayons X soit dans le faisceau de rayons X.
Appuyez sur le bouton « Acquire » (Acquérir) pour générer des rayons X et obtenir une
image. Lorsque [l'exposition aux rayons X est terminée, cliquez sur le bouton
« Estimate/Calculate » (Estimer/Calculer). Le systéme calcule le temps optimal et le nombre
est grisé. Lorsque le paramétre « Accept Setting » (Accepter le paramétre) est sélectionné,
les « Exposure Settings » (Paramétres d’exposition) sont enregistrés dans le fichier de
configuration du systéme. Remarque : Seuls les réglages ayant la case d’option
sélectionnée sont enregistrés. Effectuez ensuite une procédure d’étalonnage standard,
comme décrit dans la section « Apercu de I'étalonnage de la caméra ».

I’étalonnage
de la caméra
(suie)
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Le bouton Start Procedure (Démarrer la procédure) améne ['utilisateur a la page Patient Data 5.3 ()
Entry (Saisie des données du patient), qui propose différents moyens de saisie des données 9 .

du patient. Si aucune liste de travail n’a été configurée, I'option sera grisée et seules les options Données du patlent
Continue with current patient (Continuer avec le patient actuel), Manual Entry (Saisie manuelle)

et Select from Database (Sélectionner dans la base de données) seront accessibles. Les

options sont détaillées dans les sections suivantes.

Figure 5.3.1
< Ecran de saisie des données
du patient
Back

EC'.I.'ItII'IUE ith current patient I P E
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SAISIE MANUELLE

Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton « Manual Entry »
(Saisie manuelle). La fenétre « Patient Information Editor » (Editeur d’informations sur le
patient) s’affiche. Voir Figure 5.3.2.

HOLOGIC

Patient Name: LN cameradxa MM N B00304

Patient ID: LN B00304

Accession #: LN B00304

Date of Birth: 2007107127

Gender: Female

Procedure Name:

Laterality:

*
-

Position View:
Body Part:

Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

I
I
I
I
I
I
I
>

A
o
5
S
g
=
A
e
n-l
8
8
&
m

Remarque : Les champs obligatoires sont indiqués par un astérisque blanc (*). Les champs
obligatoires par défaut sont: Patient Name (Nom du patient), Patient ID (ID du patient),
Accession Number (Numéro d’ordre) et Laterality (Latéralité).

L’utilisateur doit compléter tous les champs requis avant de pouvoir sélectionner le bouton
« Accept » (Accepter). L'utilisateur peut également saisir la date, le médecin traitant, le nom de
la procédure, le sexe, le technicien, la vue de la position, la partie du corps et I'ID de I'étude si
nécessaire. Le nom de la procédure et la vue de la position sont choisis via un menu déroulant.

Remarque : La date doit étre saisie sous la forme année, mois, jour (par exemple 1962/08/13).
En cas de saisie incorrecte, un message d’erreur s’affiche.

Remarque : Les «champs obligatoires » peuvent étre modifiés ou supprimés selon
I'application. Contactez I'assistance Faxitron pour plus d’'informations.

Sélectionnez Accept (Accepter) pour accepter ou Start a New Patient or Procedure (Démarrer
un nouveau patient ou une nouvelle procédure) pour revenir a la page de saisie des données
du patient.

5.3.0
Données du patient
(suite)

Figure 5.3.2
Editeur d’informations sur le patient
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Une fois qu'une image est prise, les informations de I'image actuelle (propriétés de I'image)
peuvent étre visualisées en appuyant sur l'icone (i) dans le coin supérieur droit, comme le

montre la Figure 5.3.3.

La boite de dialogue est semi-transparente, pour permettre de voir ce qui se trouve en-dessous.

1.000% (2 2017/08/14 16:12:18 Monday

Dosage 280K\, 1.00 mA, 3.73 mAs, 3.73s, 0.53s, 0.00s

File Name: 120170814161219.dcm

Archiv

Folder C:\BiopticstData\

Institution Faxitron Bioptics

Si I'utilisateur souhaite modifier ou visualiser les informations aprés leur saisie et avant la prise
d’'une image, il peut appuyer sur le bouton « Patient Data » (Données du patient) dans le coin
supérieur gauche, comme le montre la Figure 5.3.5 puis saisir a nouveau les informations et
accepter les modifications en appuyant sur le bouton « Accept » (Accepter). Les autres options
permettent de sélectionner un nouveau patient ou une nouvelle procédure, ou encore d’annuler

les modifications apportées :
%

Si l'utilisateur souhaite visualiser les informations apres avoir acquis une image, il peut accéder
aux mémes données du patient, mais il ne disposera que de deux boutons. L’un pour « Close
Dialog » (Fermer la boite de dialogue) et I'autre pour « Start a New Patient or Procedure »
(Démarrer un nouveau patient ou une nouvelle procédure), qui raméne ['utilisateur a la page
de saisie des données du patient.

REMARQUE : Les informations sur le patient doivent étre saisies avant toute acquisition d’image.

Données du patient
(suite)

Figure 5.3.3
Icéne de propriétés de l'image

Figure 5.3.4
Boite de dialogue Image Properties
(Propriétés de l'image)

Figure 5.3.5
Icéne de données du patient
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En choisissant le bouton Select from Database (Sélectionner dans la base de données), 5 3 ()

la page suivante s’affiche. Voir Figure 5.3.6 ci-dessous.

Fatient 10 os112017 SPECIMEN BREAST P! 20AT/OE/L4 16:12... I0ITAOG/11

ATEG 12:09,,
Last hame
m GEMS TEST A SECINET TR T
First Name
B0308 BOD30S CAMERDANA | 200TOTIZT F
Middle Name 800322 B00322 CAMERA4RE 20UT/OS0E 17:51... 200709/ 14 “
[ o o 0HTIOEIZ 1634, IOITIOS3

Time Modified

PR0170515101 2017/05/15 10:15..
Date of Birth
50 50 o5 so 20N/ OOF 12: 3L, J0OTATEY L

Sex

4 Back

L’utilisateur peut filtrer la base de données des patients en saisissant les entrées spécifiées sur
le c6té gauche. De plus, I'utilisateur peut cliquer sur une entrée dans le tableau de la base de
données et appuyer sur « Accept » (Accepter) pour remplir I'éditeur d’informations sur le patient
avec les informations du patient.

REMARQUE : L'utilisateur peut également double-cliquer sur n’'importe quelle entrée du
tableau pour accéder rapidement a I'éditeur d’informations sur le patient sans avoir a appuyer
sur « Accept » (Accepter).

SELECTIONNER DANS LA LISTE DE TRAVAIL

(Liste de travail distante de la modalité)
En choisissant le bouton « SELECT FROM WORKLIST » (SELECTIONNER DANS LA LISTE
DE TRAVAIL), la page suivante s’affiche. Voir Figure 5.3.7 ci-dessous.

Fatient ame
Extent 1T

s et
Fr, St Do

sermmian

B, Styvicin
Sreien AT THe

Sawen hame

Les différents filtres sur la gauche peuvent étre utilisés pour rechercher des procédures
programmées pour I'entité d’application (AE) de la station de travail. Vérifiez que le titre de 'AE
de la station de travail est défini, puis tout champ unique ou toute combinaison de champs peut
étre utilisé(e) comme filtre pour rechercher des procédures programmeées pour cette AE. En
sélectionnant le bouton « Query » (Interroger) situé dans le coin inférieur gauche, le tableau
est rempli a nouveau avec les entrées correspondant aux informations recherchées.

L'utilisateur peut alors cliquer sur n’importe quelle entrée puis sur « Submit » (Soumettre) pour
remplir automatiquement I'éditeur d’informations sur le patient avec les informations du patient.

REMARQUE : L'utilisateur peut également double-cliquer sur n’importe quelle entrée du
tableau pour accéder rapidement a I'éditeur d’informations sur le patient sans avoir a appuyer
sur « Submit » (Soumettre).

Données du patient
(suite)

Figure 5.3.6

Sélection du patient a partir des
entrées de la base de données
locale

Figure 5.3.7
Boite de dialogue Rechercher la
liste de travail de la modalité
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Le bouton, illustré a la Figure 5.3.8, ouvre l'outil de réglage du niveau et du contraste de la
fenétre qui permet a l'utilisateur de régler le niveau et le contraste de la fenétre de I'image, de Réal d
la ramener au contraste d’origine en appuyant sur le bouton « Original Contrast » (Contraste _eg ag(_e e
d’origine) ou d’inverser I'image en appuyant sur le bouton « Invert » (Inverser). L'inversion fait I’lnversmn, du
passer le schéma de couleurs d’une prédominance de noir a une prédominance de blanc et  pjveau et du

inversement.
contraste des
fenétres
L’utilisateur peut également régler le curseur pour le contraste d'image désiré en
cliquant sur le curseur et en le déplagant vers le haut et vers le bas ou en cliquant Figure 5.3.8

sur l'une des fleches indiquées sur le curseur pour déplacer les limites
inférieures ou supérieures du niveau de la fenétre. Voir Figure 5.3.9
(officieusement, ceci est également connu sous le nom de « Window Leveling »
(Mise a niveau de la fenétre)).

Exemple d’inversion avec
l'outil Régler le contraste/niveau
de la fenétre

Un exemple d’inversion est présenté ci-dessous :

4

Figures 5.3.9

Exemple d’inversion avec
l'outil de réglage du
contraste/niveau de la fenétre

Original Contrast

Invert
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Ce bouton ouvre 'outil de réglage du zoom. Aprées avoir ouvert cet outil, I'utilisateur peut utiliser 5 3 2
le curseur pour régler le niveau de zoom, s’adapter a I'échantillon, s’adapter a I'’écran ou faire - .

un zoom x1,0 (pleine résolution). Lorsqu’'un zoom a été effectué sur I'image, un panoramique Reglage dynamlque
est nécessaire pour naviguer dans I'image. Une boite de dialogue sous forme de vignette du zoom

apparaitra dans le coin supérieur gauche de I'écran ; ceci permettra a I'utilisateur de déplacer

'image dans I'écran principal en cliquant et en maintenant le bouton gauche enfoncé sur

'image et en déplagant la souris. .
Figure 5.3.10

Icéne d’outil de zoom

Figure 5.3.11
Exemple de vue panoramique

ZOOM LEVEL Notez que traditionnellement, cette fonction est aussi appelée
«Pan View» (Panoramique) etlou «Pan and Scan »
(Panoramique et balayage).

_ Le bouton « Fit to Specimen » (Ajuster a I'échantillon) tente de
_ détecter et de zoomer sur I'échantillon afin de s’assurer qu'il est
_ entierement visible. Si aucun échantillon n'est détecté, il
_ reviendra par défaut au mode précédent (soit « Fit to Screen »
(Ajuster a I'écran) ou « Zoom 1.0x » (Zoom x1,0)).

Figure 5.3.12
Outil de réglage du niveau de zoom

_ Le zoom x1,0x est traditionnellement appelé « Full Resolution »
(Pleine résolution) car il offre une vue de I'image a la taille 1-1
avec la résolution du moniteur.

L’option Fit to screen (Ajuster a I'écran) ajuste I'image a I'écran.
—  1.00x

Cancel OK
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Le bouton présenté dans la Figure 5.3.13 traite 'image sur I'écran pour mettre en
valeur les détails plus petits, tels que les micro-calcifications et les petites masses
dans l'image. /

L’algorithme, communément appelé « Peripheral Equalization » (Egalisation périphérique) ou
« Thickness Equalization » (Egalisation d’épaisseur) en imagerie avancée, est appliqué a
'ensemble de I'image. En plus de cet algorithme, Faxitron utilise un deuxiéme algorithme
développé en interne appelé « Calcification Emphasis » (Accentuation de la calcification). Cet
algorithme secondaire a été congu pour faire ressortir les petits détails de 'image et les rendre
beaucoup plus faciles a voir et a analyser.

Comme les images des patients constituent une catégorie plus générale pour les géométries
et les différentes épaisseurs possibles, certains échantillons peuvent avoir des géométries
délicates et I'utilisateur doit utiliser cet outil avec précaution.

Le systéme sera inactif (en veille) pendant le traitement et une fois le traitement terminé, le
bouton restera enfoncé/actif. L'utilisateur peut annuler le processus en appuyant & nouveau
sur le bouton.

Le bouton présenté sur la Figure 5.3.14 ouvre les outils d’annotation. Ces outils
et leurs nombreuses options sont présentés plus en détail a la section 5.7.0.

Le bouton présenté a la Figure 5.3.15 fonctionne uniquement lorsque le systéme
est installé dans un établissement médical doté d'un réseau PACS. Pour
enregistrer vos fichiers localement, reportez-vous a la Section 5.5.0.

Le bouton présenté a la Figure 5.3.16 fonctionne uniquement lorsque le systeme
est installé dans un établissement médical doté d’'un réseau PACS. Pour une
impression locale, veuillez vous référer a la Section 5.5.0.

Le bouton présenté a la Figure 5.3.17 permet de quitter le mode d’acquisition
d’'image et de revenir a I'écran du Menu Principal.

Améliorer I'image

Figure 5.3.13
Icéne d’amélioration de I'image

Annotations

Figure 5.3.14
Icéne d’annotations

Enregistrement
PACS

Figure 5.3.15
Icbne d’enregistrement PACS

Impression PACS

Figure 5.3.16
Icbne d’impression PACS

Retour a la
procédure

Figure 5.3.17
Icbne de retour a la procédure
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Le bouton présenté a la Figure 5.3.18 ouvre le Panneau de commande du
dispositif, qui permet a l'utilisateur du dispositif de commander facilement le
systéeme de radiographie par le biais du logiciel. L'utilisateur peut facilement
sélectionner le mode d’exposition, le réglage des kV du tube a rayons X, le temps
d’exposition et le nombre d’'images a acquérir pour le calcul de la moyenne des
images (si désiré) ainsi que lancer I'exposition aux rayons X. D’autres options,
comme le mode « Fluoroscopie » (Floro), peuvent étre disponibles selon le systéme.

Pour I'imagerie des tissus mous, comme les échantillons de sein, le mode « Full auto »
(Entiérement automatique) est le meilleur réglage. Le systeme effectue une pré-capture et
calculera le meilleur réglage d’exposition pour le tissu.

Pour les échantillons présentant de grandes régions de densité plus élevée, par exemple de
I'os, le réglage manuel sera plus approprié. Commencez par une image en mode entierement
automatique puis, si nécessaire, passez en mode enti€rement manuel et réglez les kV pour
obtenir une meilleure pénétration dans les zones les plus denses ; augmentez le temps pour
obtenir une image globale plus lumineuse (ADU plus éleve).

() Full Auto (O Auto kv

(O Aute Time ® Full Manual

28
3.70 ...

1.00 ”

Image Averages

Start Floro Mode

Request X-Rays

< Cancel

Tournez la clé en position « OFF » (ARRET) pour arréter le systéme. Patientez 30 secondes
pour que l'ordinateur s’éteigne.

Notes supplémentaires concernant les boites de dialogue

Lorsqu’une boite de dialogue est ouverte, elle est « ancrée » a gauche de I'écran. Si un
utilisateur souhaite désolidariser la boite de dialogue, il peut cliquer sur l'icone « Pin » (Epingle)
en haut a droite pour désolidariser la boite de dialogue et pouvoir la faire glisser librement.
L’épingle se transforme alors en icdne « X » permettant une fermeture rapide.

L’utilisateur peut également naviguer rapidement entre les différentes boites de dialogue en
cliquant sur le menu de gauche. Ce faisant, le menu de gauche se ferme rapidement et ouvre
les boites de dialogue appropriées.

5.3.8
Panneau de
commande
du dispositif

Figure 5.3.18
Icéne du panneau de commande
du dispositif

Figure 5.3.19
Panneau de commande du
dispositif

5.3.9
Arrét
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Ecran d’affichage

Dans le Menu Principal, se trouve le Menu View (Affichage), qui offre diverses options a
I'utilisateur ; elles sont décrites ci-dessous.

Edit ULl Tools Image Tools DICOM Utiities Help

Zoom Mode > MNORMAL (FULL RES.)
ADJUST ZOOM

Image Averages

Image Perspective FIT TO SAMPLE
Grid Options ~ FITALL
User Window Levels FIT WIDTH

Default Window Level
Default Aspect for Raw Files

FIT HEIGHT

Enhanced Image
Sample Viewer

Magnifier Size

Review Layout

Mode Zoom

Normal
Affiche I'image acquise dans son format natif et pour les grandes images, des barres de
défilement sont fournies pour permettre visualiser 'image lorsque celle-ci dépasse la zone
graphique disponible. Le bouton de défilement central de la souris permet de faire défiler la
zone d’affichage vers le haut et vers le bas.

Adjust Zoom (Régler le zoom)
Cette option est grisée et n’est pas disponible pour I'instant.

Fit All (Ajuster tout)

Cette option affiche 'ensemble de 'image acquise, quel que soit son format d’origine. L’option
Full Resolution (Pleine résolution) ne fonctionne pas dans ce mode d’affichage.

Fit Width (Ajuster la largeur)

Cette option permet d’afficher I'image acquise sur toute la largeur disponible de la zone
d’affichage.

Fit Height (Ajuster la hauteur)
Cette option permet d’afficher I'image acquise sur toute la hauteur disponible de la zone
d’affichage.

Autres options

Image Averages (Moyennes des images)
Cette option permet a I'utilisateur de régler le nombre de moyennes d’images a prendre par
exposition.

Image Perspective (Perspective d’image)
Cette option permet a l'utilisateur de faire pivoter 'image affichée de 0, 90, 180 et 270 degrés
pour l'orienter.

Ecran d’affichage

Figure 5.3.21
Menu View (Affichage)
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Specimen Radiography System Vision

Options de grille
Ecran d’affichage
Lorsqu’une image est affichée, que ce soit une image acquise ou une image récupérée dans (suite)
la base de données, I'utilisateur peut activer une grille. Elle permet également a l'utilisateur de
régler 'espacement de la grille (pas). Voir 'exemple ci-dessous.

Figure 5.3.22
Affichage de la grille
d’échantillonnage

User Window Levels (Niveaux de la fenétre utilisateur)

Ceci permet a l'utilisateur de définir jusqu’a trois (3) niveaux de fenétre (WL) prédéfinis et
définis par I'utilisateur. Sélectionnez d’abord le bouton Window Level (Niveau de fenétre).
Réglez le niveau de fenétre (WL) sur le niveau souhaité. Dans les outils « View » (Affichage),
sélectionnez « User Window Levels » (Niveaux de fenétre utilisateur). Sélectionnez « Record
Current WL as USER WL #1, #2 or #3 » (Enregistrer le WL actuel en tant que WL
UTILISATEUR N°1, N°2 ou N°3). Le WL réglé sera enregistré sous le choix précédemment
sélectionné.

Default Window Level (Niveau de fenétre par défaut)

L’utilisateur a le choix entre deux niveaux de fenétre (WL) par défaut. Optimiser pour toute la
zone. Ceci regle le WL pour I'ensemble de I'image. L’option Optimize for sample (Optimiser
pour I'échantillon) permet de régler le WL pour la zone sous I'échantillon uniquement. De plus,
il existe une option permettant de définir le niveau de Fenétre par défaut qui est utilisé pour
toutes les images obtenues, situées ici aussi. Ceci définira le niveau de fenétre par défaut basé
sur les statistiques de I'image ; cette action devra étre effectuée séparément pour les images
non améliorées et améliorées.

Default Aspect of Raw Files (Aspect par défaut des fichiers bruts)

Cet outil est disponible sous le menu VIEW (AFFICHAGE). Il permet d’'importer/ouvrir des fichiers
d’'images précédemment enregistrés avec des attributs de fichiers inconnus ou des données
d’'images binaires sans aucune information d’en-téte. Comme la taille exacte du tableau de
limageur n'est pas disponible dans I'en-téte du fichier de données d’image, on utilisera les
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Enhance Image (Améliorer I'image),
identique au bouton du méme nom

Traite I'image actuelle du patient et améliore la visualisation des tissus situés prés de la
périphérie de I'échantillon.

Sample Alignment (Alignement de I’échantillon)
Si le systeme est équipé d’'une caméra Web, celle-ci active la visionneuse de caméra Web du
systéme pour permettre I'orientation et I'alignement de I'échantillon.

Review Layout (Mise en page de la révision)

Aide l'utilisateur a configurer plusieurs volets d'image en mode Review (Révision) (base de
données) du programme. Les options disponibles sont la mise en page double horizontale, la
mise en page double verticale, la mise en page triple et quadruple. Pendant les opérations sur
plusieurs volets, I'utilisateur peut cliquer une fois sur le volet/image désiré(e) pour en faire la
sélection courante ; la bordure rectangulaire du volet sélectionné deviendra verte. Les images
dans la vue Liste de base de données ou dans la vue Vignettes de la base de données seront
ouvertes dans le panneau sélectionné a l'aide d’un double-clic. L’utilisateur peut également
ouvrir les images dans les volets souhaités directement a partir du menu contextuel (clic droit)
des vues de la base de données mentionnées. Aprés avoir activé le menu contextuel a l'aide
d’un clic droit, I'utilisateur peut choisir parmi les volets listés sous OPEN TO — (OUVRIR DANS)
qui lui fourniront les volets disponibles pour ouvrir I'image (gauche, droite, haut, bas, etc.).

Le menu Tools (Outils) est situé dans le menu horizontal qui se trouve dans le coin supérieur
gauche de I'écran principal.

M\mageﬁo\s DICOM Utilities  Help

Preferences

Service Mode
Service Tools

Save Reference Files

Advanced Tools > AUTO SAVE ON/OFF >
PROPERTIES EDGE SUPPRESSION >
G e e TSR ’
DELETE Current Image Record X-RAY Calibration/Exposure Setup
ADD  Current Image Record P IR TSy

IMAGE ENHANCEMENT Setup
CAPTURE Screen Shot JPG/BMP Login Utilty
Save/Store current image > Cylic Automated Acquisitions
Print current image > OTHER ADVANCED User Tools >

u e _

Preferences (Préférences)

Ceci ouvre I'utilitaire de gestion de la configuration interne, qui peut étre utilisé pour modifier
diverses options. REMARQUE : La modification des paramétres de configuration sans
connaissance ou autorisation appropriée peut entrainer une perte de qualité d’image, des
dommages au systeme et un dysfonctionnement de ce dernier.

Mode Service (Entretien)

Le mode Service (Entretien) est activé a des fins de dépannage, permettant au technicien
d’accéder a des fonctions supplémentaires du logiciel Vision.

Ecran d’affichage

(suite)

Outils

Figure 5.3.23
Menu Tools (Outils)
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Options du menu Advanced Tools (Outils avancés)
Le menu Advanced Tools (Outils avancés) propose diverses options pour configurer des aspects Ou"slls
du logiciel tels que le post-traitement et les options de configuration. (suite)
Auto Save On/Off (Enregistrement automatique Marche/Arrét)
Cette option se trouve dans ADVANCED TOOLS (OUTILS AVANCES). Lorsque I'enregistrement
automatique est activé, toutes les images acquises par la suite sont enregistrées dans la base de
données du répertoire de données défini dans le fichier de configuration.
Preshot AEC Exposure Setup (Configuration de la pré-photo de
I’exposition de I’AEC)
Figure 5.3.24
Accédez au menu principal (le  Sélection de I'option Preshot AEC
Image Tools  DICOM Utilities Help menu situé tout en haut de I’écran). Exposure Setup (COﬂﬁgUratiOﬂ de
Preferences Choisissez « TOOLS » (OUTILS),  a pré-photo de I'exposition de
o « ADVANCED TOOLS » (OUTILS  JAEC)

Advanced Toals AUTO SAVE OM/OFF AVANCES) puis « PRESHOT AEC

PPP MANAGEMENT Cregaliioestal Exposure Setup » (Configuration
TILE SUPPRESSION - , "

PROPERTIES N de la PRE-PHOTO de I'exposition

o _ Ry Calibration/Exposure Setup ,

e et Image fecord PRESHOT AEC Exposure Setup de |AEC).

D IMAGE ENHANCEMENT Setup

Login Utility

CAETURE Sereen Shot G/ B A . Entrez les valeurs d’AEC pour la
R — OTHER ADVANCED User Tools PRE-PHOTO dans la fenétre ci-
Print current image dessous. Remarque : Les valeurs
dans 'image sont uniquement des
exemples. Les valeurs correctes
devront étre saisies pour votre  Figure 5.3.25

ADD Current Image Record

= @ systéme en particulier. Configuration de la pré-photo de
—PRESHOT - AEC ON/OFF PRESHOT AMALYSIS METHOD ———————————————— I’exposiﬁon de 'AEC
I TURN DN PRESHOT - 4EC DYNAMIC METHOD Pour un Faxitron Path+, les
) [&cquire Preshot Image Before Every Image. &nalyze and . Y
Tune Settings) options sont généralement 30 kV
- STATIC METHOD A
— [Analyze the Current, Loaded Image. Tune Settings] et 15 Secondes pour Ia pre-ph0t07
~ DYNAMIC PRESHOT PREFERENCES avec un ADU cible de 8 000.

PRESHOT kv DESIRED [k¥] 00

PRESHOT TIME DESIRED [s] 1.00

PRESHOT COMBINATION ‘[W]NDNE,D\ED&RD PRESHOT. SHOW 4EC SHOT ALONE H’}

;- STATIC PRESHOT PREFEREMNCES
PR G AL 7 Fe R 1] 260

B EREATERN A EETIEE] 128
A S R S _ 1 AUTO DETECT SAMPLE AREA.
Il B H I sk RIS T = AND ITS MEAM VALLE

~ EXPOSURE TUNING METHOD
@ AUTORY /AUTOTIME O AUTO Ky / FIXED TIME (FIXED kY #AUTO TIME

ERTERRTHE 5] EEENA

- THICKMESS/BEAM HARDEMING

EAUTD DETELCT SAMPLE THICKMESS
FROM PRESHOT/PRELOADED IMAGE

EMTER SOFT TISSUE EQUIMALENT = = * Preshat and AEC shat are
SAMPLE+TRAY THICKMESS (0] 0.00"=0.00cm 7 assumed to have similar
sample+ray thicknesses

[ ERGETINTERSITE GENERAL RECOMMENDATION: U
# : Use
ENTER DESIRED MEAN ez
INTENSITY UNDER SAMPLE [apL] | 70000 g”at?s?acf;;‘gzzuﬁ,‘g‘ Fleid alue For
~ PRESHOT AMALYSIS FOR STATIC PRESHOT METHOD
OFTIHIN EXFISURE FARAMETERS: [cacuiare | K=t IR0 TIHE= ]

CANCEL
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Les réglages ci-dessus reflétent une valeur de 30 kV et un temps d’exposition de 1 seconde
pour le réglage de pré-photo. Les utilisateurs peuvent entrer dans la sélection des parametres
de pré-photo uniquement en sélectionnant DYNAMIC METHOD (METHODE DYNAMIQUE)
dans la section ANALYSIS METHOD (METHODE D’ANALYSE). La sélection de STATIC
METHOD (METHODE STATIQUE) utilise les paramétres prédéfinis du Faxitron. De plus,
I'utilisateur a la possibilité de sélectionner les réglages de kV et de temps d’exposition dans la
section EXPOSURE TUNING METHOD (METHODE DE SYNTONISATION DE
L’EXPOSITION).

Pour des images plus précises, I'utilisateur peut saisir I'épaisseur du TISSU MOU (échantillon)
et FINTENSITE CIBLE dans les ADU. REMARQUE : Les valeurs indiquées dans l'image ci-
dessus sont uniguement un exemple. La valeur correcte doit étre déterminée.

Pour le mode AUTOMATIC EXPOSURE CONTROL (COMMANDE D’EXPOSITION
AUTOMATIQUE), appuyez sur le bouton START (DEMARRER) du logiciel Vision. Le logiciel
Vision effectue une pré-photo (courte, a faible dose) de I'échantillon pour créer une région
d’intérét (ROI) afin d’obtenir les paramétres d’exposition permettant d’obtenir une exposition
optimale de I'image.

Utilitaire de connexion

Il est disponible dans ADVANCED TOOLS (OUTILS AVANCES). Il permet de configurer et
d’activer l'authentification par mot de passe au démarrage du programme, si vous le souhaitez.
Les modifications souhaitées s’appliqueront uniquement si le mot de passe de I'utilisateur est
correctement saisi. Si I'authentification par mot de passe est activée, le programme demande
et vérifie le mot de passe au démarrage du programme ; il quitte le programme si le mot de
passe correct n’est pas donné.

BIOPTICS LOGIN UTILITY 6
PASSWORD | | -
MODIFY LOGIN OPTIONS B

NEW PASSWIRD
CHANGE | |
PASSWORD:  NEW PASSwWORD

VERIFY | |
Sg%ﬁf”ﬁ‘“ ™ ENFORCE PSWD AUTHENTICATION ON STARTUP
APPLY CHANGES

Outils
(suite)

Figure 5.3.26

Utilitaire de connexion. Le méme

écran s'affiche lors de

l'authentification au démarrage.
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X-Ray Calibration/Exposure Set-up (Etalonnage des 5.3.11
rayons-X/Configuration de I’exposition) Outils

Cet outil se trouve dans ADVANCED TOOLS (OUTILS AVANCES). La configuration du (suite)
générateur de rayons X/exposition aide [lutilisateur a déterminer le temps d’exposition

approprié pour un réglage kV sélectionné afin d’obtenir une meilleure qualité d'image. Veuillez

vous reporter a la section 5.2.1 et a la figure 5.2.2 pour une description plus détaillée.

I Curent SET SetFor  (vay Cal [FlabField) (O Manuallmage @) Both

Uzer TimeADU Target

Test Exposure -
et Cument -1 0o

Time [2] 2.00 ‘ Select O Time @ A0DU |
ke oray Cal 280 ADUA | 15926 Timels) | 475 | Apu [s0000 |
r:algd.:nual Acquire E stimate/Calculate

AUTOMATIC EXPOSURE CONTROL [ON THE FLY)

Magnification -1 .0oa
__ AEC Mode for Image ON [TARGET=Image ADU)

- NUMBER OF CAL IMAGES —————— " AEC Made for Flat-Field ON [TARGET =Flat-Field ADL)
#-rap Cal [Flat-Field] Averages EI

R il Ee e aehed B SR et Gorstait

~ IMAGING MODE

E.ﬁ.ppl_l,l I anual Imaging Settings On Exit, Disengage Preshat

Accept Settings I [ Cahcel

Digital Imaging and Communications in Medicine (DICOM)

Properties (Propriétés)
L’option Properties (Propriétés) masque ou affiche la boite d'informations sur I’échantillon.

Edit (Modifier)

Actuellement non utilisé.

Delete (Supprimer)
Supprime l'image actuelle du répertoire de fichiers comme spécifié dans le fichier de
configuration.

Add (Ajouter)

Ajoute I'image actuelle au répertoire de fichiers comme spécifié dans le fichier de configuration.

Print Local (Imprimer en local)
Imprime I'image actuelle sur 'imprimante WINDOWS.

Save Local (Enregistrer en local)
L’utilisateur peut « naviguer » vers le répertoire ou le dossier de fichiers dans lequel 'image
doit étre enregistrée. Un nom de fichier doit étre attribué dans le champ prévu a cet effet.
Sélectionnez un type de fichier pour I'option Enregistrer 'image sous. De nombreux types de
fichiers sont disponibles. Pour enregistrer le fichier dans un format DICOM, reportez-vous a la
section « Fonctionnalité DICOM ».

e - e Figure 5.3.27
~ra’ Nerator an oEure in Py . Lo

Y E = Boite de dialogue Générateur
~GEMERATOR SETTINGS — - EXPOSLRE SETTINGS de rayons X et exposition
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DICOM local 5.3.11
Outils
Save, Store and Print (Enregistrer, stocker et imprimer) (suite)
Cette fonctionnalité est appliquée a I'image qui est actuellement ouverte dans la session.
Reportez-vous a la section « Fonctionnalité DICOM » pour plus de détails sur ces fonctions.
Capture Screen JPG/BMP (Capture d’écran JPG/BMP)
En sélectionnant ce choix dans le menu, I'utilisateur peut faire une capture d’écran de la fenétre
active affichée. L'utilisateur peut spécifier un nom de fichier et choisir entre les formats JPG ou
BMP pour enregistrer le fichier.
Les fonctions suivantes sont disponibles pour modifier I'image acquise ou récupérée en 5 4 ()

cliquant sur le menu Image Tools (Outils Image) du menu principal. Voir Figure 5.4.1.

IMAGE TOOLS  UTILITIES  US]

ORIGINAL CONTRAST
INVERT
MAGNIFY

EDGE ENHANCE
ROI CONTRAST
ROI WINDOW L
RULER.

ROI STATISTICS
ROI HISTOGRAM
ROI PROFILE
LINE PROFILE

En sélectionnant Original Contrast (Contraste d’origine) dans le menu Image Tools (Outils
Image), les niveaux de contraste de I'image sont restaurés. Méme comportement que le bouton
Original Contrast (Contraste d’origine).

En sélectionnant Invert (Inverser) dans le menu Image Tools (Outils Image), I'image affichée
est inversée ou renversée. L’inversion d’'une image inverse sa transparence : ce qui est noir
devient blanc et ce qui est blanc devient noir. Les gris se voient attribuer leur transparence
« miroir ». Cliquez a nouveau sur Invert (Inverser) pour désactiver la fonction. Exécute la méme
fonction que le bouton Invert (Inverser).

La sélection de I'option Magnify (Agrandir) dans le menu Image Tools (Outils Image) permet a
I'utilisateur d’agrandir une zone d’intérét. Pour utiliser la fonction Magnify (Agrandir), placez le
curseur de la souris sur la zone a agrandir et faites un clic gauche. La zone d’intérét sera
agrandie. Cliquez a nouveau sur Magnify (Agrandir) pour désactiver la fonction.

Outils image

Figure 5.4.1
Menu Image Tools (Outils image)

5.4.1
Contraste d’origine

5.4.2
Inverser

5.4.3
Agrandir
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La sélection de I'option Edge Enhance (Amélioration des contours) dans le menu Image Tools
(Outils Image) crée une définition plus nette autour des bords des régions présentant une
différence de contraste. D’'une maniére générale, 'amélioration des contours peut amplifier le
bruit des images. En sélectionnant a nouveau cet élément dans le menu, vous désactivez
I'amélioration des contours. La sélection du bouton Original Contrast (Contraste d’origine)
permet également de rétablir 'image dans son état d’origine. Notez qu’il s’agit d’'une fonction
différente de la fonction Enhance Image (Améliorer I'image).

La sélection de ROI Contrast (Contraste de la ROI) dans le menu Image Tools (Outils Image)
permet d’optimiser les niveaux de contraste dans une région d’intérét (ROI) définie par
I'utilisateur. Aprés avoir sélectionné le bouton du menu ROI Contrast (Contraste de la ROI),
cliquez et maintenez le bouton gauche de la souris au point de départ de la ROI désirée, faites
glisser la souris et relachez le bouton de la souris au point final de la ROI désirée. Le contraste
se régle automatiquement sur les meilleurs niveaux pour cette ROI. (Voir la section Définitions
pour la ROI)

La sélection de la fonction RO/ Window/L (Niveau/Fenétre de la ROI) (niveau de la fenétre)
dans le menu Image Tools (Outils Image) peut étre utilisée pour ajuster le contraste et les
niveaux de luminosité de 'image dans une ROI définie par I'utilisateur. Aprés avoir sélectionné
la ROI Window/L (Niveau/Fenétre de la ROI), cliquez et maintenez le bouton gauche de la
souris au point de départ de la ROI désirée, faites glisser la souris et relachez le bouton de la
souris au point final de la ROI désirée. Voir Figure 5.4.3. Pour modifier les niveaux de contraste
et de luminosité, déplacez le curseur vers le haut ou vers le bas. Cliquez a nouveau sur ROI
Window/L (Niveau/Fenétre de la ROI) pour désactiver cette fonction. (Voir la section Définitions
pour la ROI)

Agrandir
(suite)

Figure 5.4.2
Magnify (Agrandir)

Amélioration
des bords

Contraste
de la ROI

Niveau/Fenétre
de la ROI
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Niveau/Fenétre

de la ROI
(suite)
Figure 5.4.3
Niveau/Fenétre de la ROI
En sélectionnant Ruler (Régle) dans le menu Image Tools (Outils Image), ceci permet a I'utilisateur
de mesurer la distance entre deux points dans I'image affichée. Les mesures de longueur sont en Reéal
millimétres (mm). Aprés avoir sélectionné Ruler (Régle) dans le menu Image Tools (Outils Image), egle

cliquez et maintenez le bouton gauche de la souris en commengant par le point de mesure, faites
glisser la souris et relachez le bouton de la souris au point de mesure final.

Les mesures (en mm) sont affichées dans la partie inférieure droite de la zone graphique. La
régle reste active jusqu’a ce que l'utilisateur sélectionne un autre outil d’image et une ligne
rouge reste affichée jusqu’a ce qu’une autre action soit effectuée. Voir Figure 5.4.4 ci-dessous.
Cliquez a nouveau sur Ruler (Régle) pour désactiver la fonction.

Astuce : Pour obtenir une ligne parfaitement droite ou une ligne & un angle parfait de 45 degrés,
maintenez la touche SHIFT enfoncée (sur le clavier) tout en maintenant le bouton gauche de
la souris enfoncé en la faisant glisser.
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Aprés avoir sélectionné ROI Statistics (Statistiques de la ROI) dans le menu Image Tools
(Outils Image), cliquez et maintenez le bouton gauche de la souris sur la région d’intérét (ROI)
de I'image principale, faites glisser le curseur pour faire une sélection autour de la zone, puis
relachez le bouton de la souris. Des informations statistiques seront affichées pour cette ROI
particuliere, y compris la moyenne, I'écart type, les valeurs d’intensité max/min et le nombre
total de pixels. Pour fermer la boite d'information Statistics (Statistiques), il suffit de cliquer sur
le bouton Close (Fermer). Voir Figure 5.4.5. Cliquez a nouveau sur ROI Statistics (Statistiques
de la ROI) pour désactiver la fonction.

Statistics A

Selected Region whale Image
[Top.Left)=(365.641) [Top,Left)=(0.0]
[Bottom,Right|=(1235,1088] [Bottam Right}=(2048 2048]
Minimur: 654 Minimurm: 654
Mawimum: 7239 M awimum: 12552
Mean:5903.89 Mean: 11287 06
STD:1171.48 5§TD:2399.97

| CLOSE

Régle
(suite)

Figure 5.4.4
Régle

Statistiques
de la ROI

Figure 5.4.5
Statistiques de la ROl

FAXITRON PATH+ MANUEL DE L’'UTILISATEUR | HOLOGIC | REVISION 001

HOLOGIC

5-24



Faxitron  Patht

SECTION

Logiciel
Specimen Radiography System Vision
La fonction RO Histogram (Histogramme de la ROI) du menu Image Tools (Outils Image)crée 5 4 9
un histogramme pour la ROI définie par I'utilisateur. .
Aprés avoir sélectionné I'élément du menu, placez le curseur de la souris dans I'image affichée, HIStogramme
appuyez sur le bouton gauche de la souris et maintenez-le enfoncé, puis faites glisser le de la ROI
curseur pour effectuer la sélection de la ROI souhaitée. Relachez le bouton de la souris. Un
histogramme s’affiche pour la ROI sélectionnée, voir Figure 5.4.5.
La courbe noire est I'histogramme de la région sélectionnée. La courbe bleue est I'histogramme
de l'image entiére. Les deux courbes sont normalisées par rapport a la valeur maximale du
pixel de la région d’intérét sélectionnée. Cliquez a nouveau sur RO/ Histogram (Histogramme
de la ROI) pour désactiver la fonction.
e 8 Figure 5.4.6
RO Histogramme de la ROI
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Aprés avoir sélectionné ROI Profile (Profil de la ROI) dans le menu Image Tools (Outils Image),
placez le curseur dans I'image affichée.
Tout en maintenant le bouton gauche de la souris enfonce, déplacez le curseur sur I'image 5.4.10

pour dessiner un cadre défini par 'utilisateur autour de la ROI souhaitée. Relachez le bouton
gauche de la souris et un profil s’affichera donnant la valeur individuelle du pixel de la ROI
définie ; veuillez vous référer a la Figure 5.4.7. Par défaut, la direction de moyennage de la ROI
sélectionnée est I'axe court. L’axe peut étre changé en sélectionnant le bouton SWITCH,
HOR<->VERT (BASCULER, HOR<->VERT). Cliquez a nouveau sur ROI Profile (Profil de la
ROI) pour désactiver la fonction.

Graph Diacg
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Profil de la ROI

Figure 5.4.7
Profil de la ROI
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Apres avoir sélectionné Line Profile (Profil de ligne) dans le menu Image Tools (Outils Image), 5.4.11

placez le curseur dans I'image affichée.

Tout en maintenant le bouton gauche de la souris enfoncé, déplacez le curseur sur I'image
pour tracer une ligne définie par I'utilisateur.

Relachez le bouton gauche de la souris et un profil s'affichera, montrant la valeur de chaque
pixel de la ligne définie, voir Figure 5.4.8. Par défaut, le premier point sélectionné est toujours
la partie la plus a gauche (prés de I'origine) du graphique (c’est-a-dire que I'axe horizontal du
graphique peut avoir des indices de pixels (i,j) croissants ou décroissants, selon les points de
début/fin sélectionnés). Cliquez & nouveau sur Line Profile (Profil de ligne) pour désactiver la
fonction.

Sraph Disiog ﬂ
Line Profile
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Cette fonction est une fonction « automatique ». Il n’y a aucun bouton ou élément de menu
pour la sélectionner. Une fois qu'une image a été acquise ou récupérée dans la base de
données et quelle est affichée a I'écran, un niveau de fenétre intégré est disponible
automatiquement, ce qui permet a l'utilisateur de régler les niveaux de contraste et de
luminosité de 'image.

Cliquez et maintenez le bouton gauche de la souris sur 'image affichée et déplacez le curseur
vers le haut et vers le bas pour modifier les niveaux de luminosité/obscurité ou déplacez le
curseur vers la gauche et vers la droite pour modifier les niveaux de contraste faible/élevé.
Déplacez le curseur jusqu’a ce que I'image atteigne les niveaux souhaités.

Profil de ligne

Figure 5.4.8
Line Profile (Profil de ligne)

5.4.12
Niveau de
fenétre intégré
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En appuyant sur le bouton, illustré a la Figure 5.5.1, situé en bas de la fenétre d’acquisition
d’'image, la bande des vignettes d’images du patient actuel apparait.
FaN

BROWSER

La bande des vignettes, en texte orange dans la partie supérieure, affiche la date de la
procédure pour chaque série d’'images individuelle.

L’image actuelle est mise en surbrillance en vert dans la fenétre d’acquisition d’image.

La bande des vignettes est compatible avec les opérations de glisser-déposer pour placer les
images dans la zone d’affichage des images ou dans les volets de révision, selon les besoins.
De plus, d'un simple clic, l'utilisateur peut sélectionner plusieurs images puis choisir parmi
différentes options pour enregistrer les images sur une clé USB, envoyer les images au PACS
ou supprimer les images. Les images sélectionnées sont mises en surbrillance en orange.
Des fleches s’affichent a gauche et a droite de I'écran. Dans le cas ou de nombreuses images
sont prises, I'utilisateur peut parcourir les images prises, par date croissante, en appuyant sur
les fleches gauche/droite.

L’option Open the Database (Ouvrir la base de données) est aussi disponible et fait entrer en
mode Review (Révision). Ce bouton équivaut a appuyer sur « Review Mode » (Mode Révision)
dans le Menu Principal.

e

En appuyant sur I'un ou I'autre de ces boutons, le systéme passe en mode Review (Révision),
en maintenant le systéme en veille ; il affiche la structure en tableau suivante :

O

Review

La base de données est essentiellement composée de trois sections ou sous-fenétres. La
section Patient List Table (Tableau de la liste des patients), a gauche, la section Procedure List
Table (Tableau de la liste des procédures), en haut a droite, et la section Image Thumbnail
List/Viewer (Liste/Visionneuse des vignettes d’images), en bas a droite.

Navigateur pour
les images du
patient actuel

Figure 5.5.1
Icéne du navigateur pour les
images du patient actuel

Figure 5.5.2
Navigateur pour les images
du patient actuel

Base de données

Figure 5.5.3, 5.5.4

Bouton Image Database (Base de
données d'images) du navigateur
pour les images du patient actuel.
A droite, l'icéne du mode de
révision affichée dans le

menu principal.

Figure 5.5.5
Image Database
(Base de données d’images)
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Les tableaux des listes fonctionnent selon une hiérarchie descendante comme indiqué par la

fleche ,
éche Base de données

Liste des patients--->Liste des procédures--->Liste/Visionneuse des vignettes d'images. (suite)

- La fenétre de sélection du patient est la fenétre située la plus en haut a gauche. La fenétre
des procédures est la fenétre située la plus en haut a droite.

 Lorsqu’un champ Patient est sélectionné, la fenétre de procédure devient active. La fenétre
de procédure affiche une liste de toutes les procédures effectuées pour le patient sélectionné.
De plus, toutes les images correspondant au patient sont affichées en bas a droite. Il n’est
pas possible de sélectionner plusieurs patients.

Lorsqu’une procédure est sélectionnée, la liste/visionneuse des vignettes est filtrée pour
afficher uniquement les images correspondant a la procédure sélectionnée. En maintenant
la touche Maj enfoncée, I'utilisateur peut sélectionner plusieurs procédures pour visionner les
images.

Le tri de la base de données peut étre réglé en cliquant sur les champs supérieurs tels que
I'ID du patient et le nom de famille pour trier selon I'un ou 'autre des critéres. Lorsqu’un clic
de souris est fait sur 'un des champs de la base de données, une petite fleche s’affiche dans
le champ. En utilisant le bouton gauche de la souris et en sélectionnant a nouveau le champ,
le dessin de la fleche passe d’ascendant a descendant ou inversement. Le champ
sélectionné sera automatiquement trié en conséquence.

Des barres de défilement sont situées dans la base de données pour faciliter la navigation.

La liste/visionneuse des vignettes permet & un utilisateur de cliquer sur le symbole « + » pour
ajouter automatiquement I'image a un volet de révision. Un utilisateur peut ajouter jusqu’a
quatre images dans les volets de révision. Les volets de révision sont automatiquement
ajustés pour englober les quatre images.

Les mémes options que celles disponibles dans le navigateur d’images des patients actuels
se trouvent également en haut de la base de données. Toutefois, des options
supplémentaires sont également disponibles ; elles sont décrites dans la section 5.5.2.

Remarque importante : Les vignettes des images (.PNG) sont des fichiers distincts des
fichiers de données d’'images (DCM, DAT, DMM, RAW). Elles portent le méme nom de fichier
que le fichier d’'image, mais elles ont une extension de fichier (.PNG). Il est possible d’avoir un
fichier image mais pas de « vignette ». Dans ce cas, Vision tentera de créer automatiquement
une vignette pour I'image qui doit étre chargée dans la base de données. Cependant, si cette
opération échoue, 'image ne sera pas affichée.

Save Image(s) (Enregistrer la/les images(s))

Le bouton « Save Image(s) » (Enregistrer la/les image(s)) est disponible lorsqu’une entrée du
tableau des images ou de la liste des vignettes est sélectionnée ou par le biais des images
patient actuelles, sinon il est désactivé. L'image sélectionnée peut étre enregistrée dans les
formats d’image 8 bits courants suivants : JPEG, BMP, TIFF, RAW. Elle peut également étre
enregistrée au format TIFF 16 bits.

Le niveau de fenétre de I'image enregistrée est le niveau de fenétre par défaut. Si I'utilisateur
souhaite que le niveau de la fenétre soit modifié, il doit charger I'image dans Vue d’'image et

'imprimer a partir de cet emplacement plutot que de I'imprimer a partir de la boite de dialogue
de la base de données.

Send Image(s) to PACS (Envoyer une/des image(s) au PACS)

Cette fonction envoie un ou des images a un serveur PACS DICOM préconfiguré.
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Fonctions et outils du menu de la base de données d’images 5.5.2
Options

Il existe des fonctions pour naviguer, rechercher dans la base de données et pour modifier,
supprimer et ajouter des enregistrements a la base de données. Ces fonctions sont détaillées
dans les éléments du menu de la base de données. On y accéde a partir du bouton supérieur
intitulé « Additional Options » (Options supplémentaires) dans la base de données.

ADDITIONAL OPTIONS

Open
Print
View

Search
Tools

Close Database
P20170619104813 B00304

Menu View (Affichage)

Show All DB Entries (Afficher toutes les entrées de la BD)

Recharge le tableau Patient a partir du fichier de la base de données. Tout nouveau
changement ou ajout a la base de données sera appliqué au tableau. Cette sélection efface
également tout « SEARCH FILTER » (FILTRE DE RECHERCHE) actif qui aurait pu étre
appliqué aux tableaux. L'option « SEARCH FILTER » (FILTRE DE RECHERCHE) est
expliquée en détail dans la partie DB-SEARCH (RECHERCHER BD) ci-dessous.

Refresh DB Entries (Rafraichir les saisies de la BD)

Rafraichit le tableau des patients, mais conserve tout « SEARCH FILTER » (FILTRE DE
RECHERCHE) existant qui a été appliqué.

Browse Data Directory (No DB)
(Parcourir le répertoire des données (pas de BD))

Affiche toutes les vignettes d’'images dans le répertoire des données établi par le fichier de
configuration. Ces fichiers sont affichés dans la visionneuse de vignettes. lls ne sont associés
ni & la base de données, ni aux listes des tableaux. Cet outil est utile pour examiner les images
non enregistrées ou pour déboguer les probléemes de base de données lorsque des images
sont présentes dans le répertoire de données actuel.

Browse Any Directory (No DB)
(Parcourir n’importe quel répertoire (pas de BD))

Permet a I'utilisateur de naviguer dans n’importe quel répertoire de fichiers. Ces fichiers sont
affichés dans la visionneuse de vignettes. lls ne sont associés ni a la base de données, ni aux
listes des tableaux. Cet outil est utile pour examiner un répertoire d'images qui n’a jamais été
enregistré dans la base de données ou lorsque les enregistrements de la base de données
sont corrompus.

supplémentaires de
la base de données

Figure 5.5.6
Menu Additional Options
(Options supplémentaires)
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Menu Search (Rechercher) Options

supplémentaires de

Les outils de recherche dans la base de données permettent d’effectuer des recherches la b_ase de donnees
détaillées ou de filtrer la base de données. En sélectionnant le menu DB-SEARCH (suite)
(RECHERCHER BD), une recherche détaillée et spécifique peut étre effectuée. Lorsque le

critére de recherche est saisi et activé dans la boite de dialogue de recherche de la base de

données (expliqué ci-dessous), le filtre de recherche est appliqué a tous les tableaux de listes

de la boite de dialogue de la base de données d'image. Le critére de recherche activé est

appelé « SEARCH FILTER » (FILTRE DE RECHERCHE) et ce filtre reste actif jusqu’a ce que

I'utilisateur sélectionne « STOP SEARCH » (ARRETER LA RECHERCHE) dans le menu DB-

SEARCH (RECHERCHER BD) ou « SHOW All DB Entries » (MONTRER toutes les entrées de

la BD) dans le menu DB-VIEW (AFFICHER BD). Le « SEARCH FILTER » (FILTRE DE
RECHERCHE) actif est toujours affiché dans la Iégende de la boite de dialogue de la base de

données d'images.

START SEARCH (DEMARRER LA RECHERCHE)

« START SEARCH » (DEMARRER LA RECHERCHE) ouvre la boite de dialogue de recherche
de la base de données, ce qui permet de placer un FILTRE DE RECHERCHE actif sur la base
de données.

DB SEARCH Dialog (&)

Figure 5.5.7
SEARCH BY: Enter ACCESSION NLUIMBER geEan:rgg;CteEug%
| [AccessionMumber] l‘#’) | |

CLICK 0K~ TO ACTIMATE SEARCH FILTER ON THE DATABASE

[ 0K l [ Cancel

Les menus déroulants proposent des listes de catégories de recherche. Sélectionnez une
catégorie de recherche et saisissez le paramétre de recherche souhaité pour lancer la
recherche. Sélectionnez le bouton Start (Démarrer) pour lancer la recherche. Si une catégorie
a plus d'une entrée distincte, alors toutes les entrées de cette catégorie seront affichées.

STOP SEARCH (ARRETER LA RECHERCHE)

« STOP SEARCH» (ARRETER LA RECHERCHE) désactive tout «FILTRE DE
RECHERCHE » actif, efface tous les tableaux de listes et recharge la liste de tous les patients
dans le tableau de la liste des patients.
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Menu Tools (Outils) Options

supplémentaires de

Le menu « DB-TOOLS » (OUTILS DE BD) fournit des fonctions par image, par procédure, par  la base de données
patient, ainsi que des fonctions utiles pour réparer ou reformater la base de données. (suite)

ADD Record (AJOUTER un enregistrement)

Disponible lorsque la saisie a partir du Tableau des images ou de la Liste des vignettes est
sélectionnée, sinon cette fonction est désactivée. Ceci est particulierement utile lorsqu’un
répertoire est parcouru alors que la base de données ne dispose d’aucune entrée pour les
images dans ce répertoire. L'utilisateur peut sélectionner une seule image dans la liste des
vignettes et ajouter des enregistrements de cette image dans la base de données. Si I'entrée
de la base de données existe déja pour I'image sélectionnée, il N’y a aucun danger, elle ne
peut que mettre a jour la base de données en fonction de I'endroit ou se trouve actuellement
le fichier image, c’est-a-dire le nom du fichier/dossier.

EDIT Record (MODIFIER un enregistrement)

L’élément « EDIT Record » (MODIFIER un enregistrement) est disponible lorsque la saisie a
partir du tableau des patients ou des procédures est sélectionnée ; cette option est désactivée
lorsque la saisie d'image est sélectionnée. La fonction « EDIT Image Record » (Modifier
I'enregistrement de limage) n'est pas disponible actuellement dans le logiciel Vision.
L’utilisateur doit remplir la zone en fonction du niveau de sélection qui est soit Saisie de
procédure, soit Saisie de patient. Les entrées de l'autre niveau sont désactivées. Comme
indiqué ci-dessous, lorsque I'utilisateur sélectionne une entrée de procédure dans le tableau
des procédures pour la modifier, les paramétres de la procédure seront activés pour étre
modifiés et les autres seront désactivés (parameétres du patient). L'ID du patient ne doit jamais
étre modifié.

IMPORT Records in DIR to DB
(IMPORTER des enregistrements de REP vers BD)

Cet outil permet de parcourir et de sélectionner un dossier, puis de remplir la base de données
avec toutes les entrées correspondantes pour tous les fichiers image dans le répertoire
sélectionné (y compris les sous-répertoires). Les formats d’'images peuvent étre DCM, DAT,
DMM, RAW. Si des vignettes d’images manquent, cet outil générera également des vignettes
BMP dans le méme répertoire.

REFORMAT ALL DB (REFORMATER TOUTE LA BD)

L’outil « REFORMAT ALL DB » (REFORMATER TOUTE LA BD) permet de reformater les
champs Date [AAAA/MM/JJ], Date/Heure [AAAA/MM/JJ HH:MM:SS] des tableaux et de mettre
en majuscules les lettres des entrées de certains autres champs. C’est un outil utile lorsqu’un
ancien fichier de base de données est importé et ouvert pour la premiére fois ou lorsque
I'utilisateur modifie manuellement les entrées de la base de données a l'aide de MS Access.
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Menu Print (Imprimer) Options

Le menu « DB-PRINT » (IMPRIMER BD) offre des fonctionnalités d’impression par image, par
procédure et par patient.

PRINT LOCAL Image (IMPRIMER L’'IMAGE LOCALE)

L’élément « PRINT LOCAL Image » (IMPRIMER L'IMAGE LOCALE) est disponible lorsque la
saisie a partir du tableau des images ou de la liste des vignettes est sélectionnée, sinon il est
désactivé. L'image sélectionnée sera imprimée avec I'imprimante locale par défaut du systéme
Windows.

Le niveau de fenétre de I'image imprimée est le niveau de fenétre par défaut. Il n’est pas
recommandé aux utilisateurs d'imprimer a partir de ce menu, sauf s’ils sont satisfaits des
impressions définies avec les niveaux de fenétre par défaut calculés par le programme.
L’utilisateur peut d’abord charger I'image dans la fenétre Image View (Vue d’'image) (Révision)
et ensuite régler 'image aux niveaux de fenétre souhaités. Lorsqu'’il est satisfait du niveau de
la fenétre, I'utilisateur peut alors lancer I'impression a partir du menu de la fenétre Image View
(Vue d’image). Une boite de dialogue Format Options (Options de formats) permet de choisir
entre les formats d'impression.

PACS PRINT (IMPRESSION PACS)

Cette fonction envoie la ou les images a une imprimante DICOM préconfigurée.

Remarques supplémentaires sur la base de données

e La possibilit¢ de quitter la base de données, en restant dans le mode Review
(Révision) se trouve dans Additional Options (Options supplémentaires).

e Le bouton en haut a gauche se régle automatiquement pour ramener ['utilisateur a
I'acquisition, au menu principal, ou il devient le bouton « Close Database » (Fermer la
base de données) selon le flux de travail utilisé pour aller a I'écran de la base de
données et ce qui est le plus approprié.

Différence entre PRINT (IMPRIMER) et
PRINT LOCAL (IMPRIMER EN LOCAL) ou entre SAVE
(ENREGISTRER) et SAVE LOCAL (ENREGISTRER EN LOCAL)

En plus de «PRINT LOCAL..» (IMPRIMER EN LOCAL), « SAVE LOCAL...»
(ENREGISTRER EN LOCAL) et « DICOM SAVE LOCAL... » (ENREGISTRER DICOM EN
LOCAL), il y aura des options ou boutons « non spécifiés » dans le menu déroulant PRINT
(IMPRIMER) et SAVE (ENREGISTRER). Ces menus et ces boutons d’outils invitent I'utilisateur
a choisir entre IMPRIMER sur le systétme LOCAL (fourni par linfrastructure du systéme
Windows) ou I'environnement réseau DICOM (fourni par l'infrastructure réseau DICOM de ce
programme) ; il permettent aussi de choisir ’'ENREGISTRER l'image dans un format JPEG
8 bits, BMP, TIFF, RAW ou dans un format DICOM 16 bits ou TIFF 16 bits.

supplémentaires de
la base de données

(suite)
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La norme DICOM 5.6.0
Fonctionnalité
Qu’est-ce que la norme DICOM ? DICOM
La norme DICOM (Digital Imaging and Communications in Medicine) est une série de
protocoles utilisés par les équipements et les logiciels médicaux pour permettre aux données
d’étre compatibles et interchangeables avec d’autres équipements ou logiciels médicaux.
Lorsqu’un fichier est enregistré dans un format DICOM, un fichier est créé. Celui-ci comprend
les données pertinentes du patient, les données de I'équipement d’imagerie et du matériel ainsi
que les données d’'image, le tout dans un seul fichier. De plus, le fichier enregistré contient des
caractéristiques spécifiques qui permettent a I'ordinateur et au logiciel de I'identifier comme un
fichier conforme a la norme DICOM. Une fois qu'une application logicielle reconnait le fichier
comme un fichier conforme a la norme DICOM, elle peut lancer un lecteur DICOM et extraire
les données correctement, quelle que soit I'origine du fichier.
Un fichier créé a I'aide du protocole DICOM a la structure suivante :
Figure 5.6.1
Structure du protocole DICOM
Preamble He ader P
Prefix

Data Element

Data Element

Data Element

Data Element Data Set

Data Element

Data Element
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Lorsque le préambule est constitué de 128 octets, tous sont généralement définis sur 00H, sauf
s’il n’est pas utilisé par un profil d’application ou une implémentation spécifique ; le préfixe est
constitué de 4 octets, constituant la chaine de caracteres « DICM » codée en majuscules du
répertoire de caractéres GO de la norme ISO 8859 ; les éléments de données sont
arbitrairement grands (ou petits) et contiennent les données.

Modalité

Les paramétres du fichier DICOM pour la Modalité sont accessibles a partir du menu principal
Tools (Outils). Dans le menu Tools (Outils), il est possible de sélectionner « DICOM Modality
Setup » (Configuration de modalité DICOM).

Le type de stockage DICOM, soit Présentation soit Traitement, peut étre sélectionné. La méme
boite de dialogue permet de sélectionner la modalité d'image DICOM, soit radiographie
numérique soit mammographie numérique. Les paramétres « Transfer Syntax » (Syntaxe de
transfert) et « Value Representation » (Représentation de valeur) ne peuvent pas étre définis
par I'utilisateur. lls sont toujours paramétrés sur META HEADER PRESENT, LITTLE_ENDIAN
et VR_IMPLICIT.

- Dicom FilesTransfer Settings

| DICOM Servers... |

REMARQUE : Une fois les modalités DICOM sélectionnées, elles restent en vigueur, méme
aprés la fermeture du logiciel Vision. Les paramétres de la modalité sont stockés et resteront
mémorisés dans la configuration jusqu’a ce qu'ils soient modifiés a nouveau, en utilisant les
parameétres du fichier DICOM. Ces parametres (de type de stockage et de modalité, de syntaxe
de transfert, de représentation des valeurs) seront effectifs pour toutes les fonctionnalités
DICOM « LOCAL SAVE » (ENREGISTRER EN LOCAL) ou « LOCAL PRINT » (IMPRIMER EN
LOCAL).

5.6.0
Fonctionnalité
DICOM

(suite)

Figure 5.6.2

Parametres de Modalité DICOM

Paramétres par défaut
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Default DICOM Servers (Serveurs DICOM par défaut)

Cette section contient des paramétres pour les serveurs DICOM par défaut et pour automatiser ~ Fonctionnalité
certains des processus lors du stockage, de I'impression ou de la recherche de serveurs PACS  DICOM
et MWL. .

Les cases a cocher « Enable Single-Click Auto Store » (Activer le stockage automatique en un (swte)
seul clic), « Print» (Imprimer) ou « MWL Connection » (Connexion MWL) permettent a

I'utilisateur de stocker ou d’'imprimer des images ou de se connecter automatiquement au

serveur MWL. Si vous utilisez un seul serveur PACS pour ces actions ou si la majorité de votre

travail concerne un seul serveur PACS, cochez la case souhaitée pour automatiser ces actions.

La case « Enable Auto Search When Connecting to MWL Server » (Activer la recherche

automatique lors de la connexion au serveur MWL) indique a I'application d’effectuer
automatiquement une recherche avec les parameétres de recherche par défaut lors de la

recherche des données des patients.

La case «Autoclose dialog after N seconds of successful transfer/printing » (Fermeture

automatique de la boite de dialogue aprés N secondes de transfert/impression réussi(e)) ferme
automatiquement la boite de dialogue du réseau DICOM aprés un nombre de secondes spécifié.

La boite de dialogue ne se ferme pas automatiquement en cas d’erreur de transfert ou d’'impression.

Cliquer sur le bouton « DICOM Servers » (Serveurs DICOM) ouvre la boite de dialogue réseau

DICOM ou un utilisateur peut ajouter, modifier ou supprimer des serveurs DICOM.

Saving a DICOM File (Enregistrement d’un fichier DICOM)

Cette option de commande apparait a plusieurs endroits dans le logiciel Vision, voir « DICOM
SAVE LOCAL » (ENREGISTRER DICOM EN LOCAL).

DICOM SAVE LOCAL (ENREGISTRER DICOM EN LOCAL)

L’option DICOM Save (Enregistrer DICOM) (qui est disponible a différents endroits dans le
logiciel Vision) affiche la fenétre suivante. L'utilisateur peut saisir le nom du fichier sous lequel
les informations de la procédure doivent étre stockées. De plus, l'utilisateur peut sélectionner
le dossier dans lequel il souhaite enregistrer le fichier.

PACS STORE (ENREGISTREMENT PACS) et PACS PRINT
(IMPRESSION PACS)

Le logiciel Vision permet I'enregistrement PACS (DICOM) et 'impression PACS (DICOM). Ces
options sont disponibles dans I'ensemble du logiciel. Par exemple, si le bouton PACS Store
(Enregistrement PACS) est sélectionné, la fenétre suivante de dialogue avec le réseau DICOM
peut étre affichée.

= DICOM Networking Dialog - Bioptics Vision nNOee
SESSION  SECURMY  VIEW COMWMAND PREFERENCES

Figure 5.6.3
Boite de dialogue DICOM
Networking (Réseau DICOM)

DICOM Mebwork Connections:

[ ADDSession | g =
[ MODIFY Sesson | purcrone ovTmwL VT PRINT

REMOWVE Session StP SEP SCP
ASSOCIATION List

T et |
[ oscowecr
[ ccroonor
[ scosonnio

FIND WORKLIST |
STORE |
PRINT |

DICOM Metwork Meszages Log:

CLOSE
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A partir de cette boite de dialogue affichée, I'utilisateur peut choisir de faire un enregistrement
ou une impression DICOM. Cette boite de dialogue permet a I'utilisateur d’ajouter, de modifier
ou de supprimer des connexions réseau ou des périphériques DICOM.

PACS DICOM STORE (ENREGISTREMENT PACS DICOM)

Le logiciel Vision prend en charge le service C-STORE DICOM 3.0. Ceci permet d’envoyer une
image ou une série d’'images (selon une procédure spécifiée) a un systeme de stockage distant
conforme a I'entité d’application (AE) DICOM, comme le PACS. La encore, la fonction DICOM
Store (Enregistrement DICOM) est accessible dans I'ensemble du logiciel Vision. Les
modifications de la présentation et du traitement peuvent étre effectuées par le biais de la
configuration de la modalit¢ DICOM, dans le menu Tools (Outils). Remarque : Pour
I'enregistrement DICOM, la case « SET FILM Attributes » (PARAMETRER les attributs du film)
est grisée.

L’utilisateur peut ajouter une nouvelle configuration pour une AE DICOM distante a laquelle
envoyer I'image ou choisir parmi une configuration déja existante, affichée dans Connexions
réseau DICOM, dans la boite de dialogue DICOM Networking (Réseau DICOM). En double
cliquant (ou avec un seul clic et en appuyant sur le bouton Connect) sur I'icone de 'AE DICOM
distante, le logiciel Vision se connecte et établit une association DICOM avec I'AE distante
sélectionnée. Une fois que l'association réussie, I'image peut étre envoyée pour étre
enregistrée en appuyant sur le bouton Store (Enregistrer). Aprés avoir sélectionné le bouton
Store (Enregistrer), le logiciel Vision envoie 'image sélectionnée a I'AE DICOM distante définie.
Si 'opération de mémorisation est réussie, 'AE DICOM distante envoie une confirmation de
réception et d’enregistrement de la ou des images. Si I'opération échoue, 'AE DICOM distante
enverra un code d’erreur indiquant la raison de I'échec.

Une seule image peut également étre envoyée pour étre enregistrée en cliquant avec le bouton
droit de la souris sur la vignette de I'image (dans le navigateur de la base de données) et en
suivant la méme procédure que celle décrite précédemment. Il est possible d’envoyer toute une
série (Procédure) d’images pour enregistrement. Pour ce faire, cliquez avec le bouton droit de
la souris sur le nom de la série (Procédure), affiché dans I'écran du navigateur de base de
données, puis suivez le méme protocole que celui décrit ci-dessus.

Add Session (Ajouter une session)

Le bouton Add Session (Ajouter une session) ouvre la boite de dialogue de session par laquelle
I'utilisateur peut configurer une nouvelle connexion a une entité d’application DICOM distante.

Pour créer une nouvelle configuration de connexion a une AE DICOM distante, I'utilisateur doit
disposer des informations suivantes : le titre de I'entité d’application (AE Title), le choix de la
« fonction a exécuter » DICOM/PACS, l'adresse IP et le numéro de port du serveur (c’est-a-
dire de I'imprimante DICOM ou du systéme PACS).

Le titre AE et le numéro de port du systéme de I'utilisateur (c’est-a-dire. le client) sont également
nécessaires. Remplissez les champs de données correspondants et sélectionnez OK pour
créer une nouvelle configuration.

Fonctionnalité
DICOM
(suite)
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Iy a actuellement quatre (4) types de fonctions qu’une session DICOM peut utiliser par defaut.  (suite)
Celles-ci se trouvent dans la liste déroulante Fonctions (cases combinées) comme indiqué dans
les figures ci-dessous. La liste est :

1. Connexion GENERAL (GENERALE) DICOM/PACS.

2. Connexion STORE (ENREGISTREMENT) DICOM.

3. Connexion WORKLIST (LISTE DE TRAVAIL) de la modalité.
4. Connexion PRINTER (IMPRIMANTE) DICOM.

Figure 5.6.4
Boite de dialogue Session

Properties (Propriétés
e de la session)

Cancel

BIOPTICS_DR

Figure 5.6.5
Fonctions présentées

[ o« |
[ Concel |

STOR

I
WORKLIST
o]

BIOPTICS_DR

®
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Le but de la « Fonction » DICOM est de permettre la création (I'ajout) d’'une Session/Connexion 56.0

qui a son tour permet d’utiliser un « dispositif » DICOM/PACS uniquement tel que I'utilisateur
I'a configuré pour une catégorie de fonctions particuliére.

Une fois configuré, lorsque vous visualisez ou utilisez la « DICOM Networking Dialog » (Boite
de dialogue réseau DICOM) (voir Figure 5.6.3 ci-dessus), seule l'icone correspondant a la
fonction choisie sera « active et illuminée ». C’est-a-dire qu’elle aura une couleur bleue par
opposition a une couleur « grisée ». Par exemple, dans la Figure 5.6.3 ci-dessus, nous avons
trois (3) icones représentant, dans l'ordre, un Enregistrement PACS, une Liste de travail de
modalité et une Imprimante DICOM. Parce que le bouton PACS Store (Enregistrement PACS)
(voir Figure 5.3.16) a été choisi précédemment, seule I'icone PACS Store (Enregistrement
PACS) (DVTK STORE SCP) est active. Les autres modes fonctionnent de la méme maniere.

Modify Session (Modifier la session)

Le bouton Modify Session (Modifier la session) ouvre la boite de dialogue pour 'AE DICOM
sélectionnée. Dans cette fenétre, I'utilisateur peut modifier les informations du serveur et du
client décrites dans la partie Ajouter une session.

Remove Session (Supprimer la session)

Le bouton Remove Session (Supprimer la session) supprime la configuration de 'AE DICOM
sélectionnée du logiciel Vision.

Une fois supprimée, une configuration AE DICOM ne peut pas étre restaurée, sauf si l'utilisateur
saisit a nouveau manuellement les données requises par le biais du bouton Add Session
(Ajouter une session). Une confirmation d’action sera demandée, voir ci-dessous.

Bioptics Vision -

6 Are you sure you want to remove this DICOM Network Connection?

Yes ] [ Mo

Fonctionnalité
DICOM
(suite)

Figure 5.6.6

Vérification de la suppression
d’une connexion réseau
DICOM existante
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L o . _ o Fonctionnalité
Le bouton Association List (Liste des associations) ouvre la boite de dialogue Association, DICOM
représentée ci-dessous, grace a laquelle I'utilisateur peut modifier les parameétres et les g
protocoles utilisés par le logiciel Vision lors de la négociation d’'une connexion avec une AE (smte)
DICOM distante. Ces options doivent étre modifiées uniquement par un utilisateur avance,
familiarisé avec les protocoles d’association DICOM.
Figure 5.6.7

1.2.84010008.3.1.1.1 ; .
Cancel |

16384 T "
1.2.840.114257.1123456

B Digital %-Fay Image Storage - For Presentation
B4 Digital %-Fay Image Storage - For Processing :

B Digital Mammography #-Fay Image Storage - For Prezental .
(] Digital Mammography #-Fay Image Storage - Far Processir

(] Grayscale Softcopy Presentation Stake Storage |

ey |
[ oeeut |

Attributs du film

La sélection du bouton Set Film Attributes (Définir les attributs du film) affiche la boite de
dialogue Film Session (Session du film). Dans cette boite de dialogue, I'utilisateur peut
sélectionner diverses options régissant le film et le format d'impression. La sélection de I'option
Default (Par défaut) rétablit toutes les options par défaut. Les configurations des paramétres
sont accessibles via des menus déroulants. Pour accepter la configuration modifiée,
sélectionnez OK. Pour rejeter les options et quitter la fenétre sans apporter aucun changement,
sélectionnez Cancel (Annuler).

Fenétre Association DICOM
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Fonctionnalité
DICOM

(suite)

Blue Film

Figure 5.6.8
Boite de dialogue Configuration
de l'imprimante DICOM

Magazine
Fartrait

Black

REFLICATE
AlME10IN

M

ormal

b edium

ni
!ﬂ

PACS PRINT (IMPRESSION PACS)

L’option d’impression PACS envoie l'image sélectionnée a limprimante PACS DICOM
sélectionnée. L'image est imprimée selon les options de format de film et d’impression
spécifiées dans la boite de dialogue Set Film Attributes (Configurer les attributs du film) décrite
précédemment. Si l'utilisateur lance I'impression PACS a partir de Image View (Vue image),
alors le niveau de la fenétre sera choisi dans cette vue image. Si I'impression PACS est lancée
a partir de la boite de dialogue Base de données, alors le niveau de la fenétre sera le niveau
de fenétre par défaut calculé par le logiciel Vision.

Close (Fermer)

Le bouton Close (Fermer) ferme la boite de dialogue DICOM Networking (Réseau DICOM) et
fait revenir I'utilisateur dans la zone a partir de laquelle la commande DICOM a été exécutée.
Cette commande ferme également la connexion ou I'association entre le logiciel Vision et le
périphérique DICOM distant si une connexion a été établie.
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Overview (Vue d’ensemble)

L’'option User Annotations (Annotations de l'utilisateur) dans le logiciel Vision permettent
d’appliquer une « superposition » graphique transparente sur une image, communément
appelée « annotations ». Ces annotations peuvent étre un texte, des lignes, des lignes de
« forme libre » (courbes de Bézier), des fleches, des ellipses et des boites. Cela permet
d’ajouter des informations supplémentaires et des « marqueurs » sur I'image si besoin. Notez
que toutes les annotations peuvent étre facilement activées ou désactivées, en d’autres
termes, elles peuvent étre affichées ou masquées a volonté.

Fonctionnement

Pour commencer I'annotation, sélectionnez 'outil « Annotations » (Annotations) dans le menu
de gauche. Voir la Figure 5.7.1 pour plus d’informations. En ouvrant cette boite de dialogue, le
logiciel met immédiatement I'utilisateur en mode conception. Il affichera aussi une « palette
d’outils ». Voir ci-dessous

Le fait de sélectionner « Save » (Enregistrer) ou « Cancel » (Annuler) dans cette boite de
dialogue annulera les annotations précédentes ou enregistrera les annotations actuelles dans
la fenétre. Il vous raménera également au mode d’imagerie normal.

La palette d’outils est composée des quinze (15) options d’outils suivants. Cependant, les outils
peuvent étre tronqués aux 8 outils les plus courants, en fonction des besoins de I'utilisateur ;
ils sont affichés dans la ligne supérieure de la boite de dialogue. Notez que le comportement
de la plupart de ces options d’outils implique l'utilisation de la souris pour guider la position et
la forme dynamiques a I'écran. Les « clics » de la souris sont utilisés pour définir les positions
et les formes finales. Le terme « balayer » signifie que I'on maintient le bouton gauche de la
souris enfoncé et que I'on déplace I'objet sur I'écran. Le fait de relacher le bouton gauche de
la souris ou de cliquer sur le bouton droit de la souris, mettra I'annotation en position
« permanente » ou finale.

MNew Preset Name Here

Add as New Preset

En commencant dans le coin supérieur gauche de la figure ci-dessus, une description de
chaque option d’outil est donnée ci-apres.

Outil de sélection : Utilisez cet outil pour sélectionner (mettre en surbrillance) un objet
d’annotation courant. Cliquez et maintenez le bouton gauche de la souris enfoncé, ce qui définit
une position de départ, puis déplacez la souris. Les annotations qui se trouvent a I'intérieur de
la boite affichée seront sélectionnées pour une utilisation ultérieure. Relachez le bouton gauche
de la souris pour terminer I'opération.

5.7.0
Annotations des
utilisateurs

Figure 5.7.1

Conception des Annotations
des utilisateurs

Palette d’outils
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¢ Outil ligne : Cette option permet de tracer une ligne droite. Le comportement de la souris
est le méme que ci-dessus.

Outil boite : Dessine une boite. Le comportement de la souris est le méme que ci-dessus.

Outil ellipse (et cercle) : Dessine une ellipse ou un cercle. Le comportement de la souris
est le méme que ci-dessus.

Outil fleche : Dessine une ligne avec une fléche a son extrémité. Le comportement de la
souris est le méme que celui de I'outil ligne.

Outil ligne ouverte de polygone : Dessine des lignes non droites « a segments ouverts ».
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relachez
le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que désiré. Cliquez
sur le bouton droit de la souris et le fonctionnement de I'outil se termine.

Outil texte : Crée une « zone de texte » ou vous pouvez saisir des données sous forme de
texte.

Outil régle : Crée un segment de ligne gradué. Trés similaire & la fonction Régle des outils
d’'image.

Outil ligne fermée de polygone : Dessine des lignes non droites « a segments fermés ».
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relachez
le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que désiré. Cliquez
sur le bouton droit de la souris et le fonctionnement de I'outil se termine.

Outil ligne courbe ouverte : Dessine des lignes courbes « ouvertes et segmentées ».
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé,
dessinez. Relachez le bouton de gauche, cela définit un segment de ligne courbe. Répétez
autant de fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de
I'outil se termine.

Outil ligne courbe fermée : Dessine des lignes courbes « fermées et segmentées ».
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton enfonceé,
dessinez. Relachez le bouton de gauche, cela définit un segment de ligne courbe. Répétez
autant de fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de
I'outil se termine.

Outil infobulle (texte) : Crée une zone de texte avec un segment de ligne dépassant d’un
coin de la zone de texte. Ceci peut étre utilisé pour « relier » le texte a un élément sur votre
image.

Régle segmentée : Dessine des lignes graduées non droites « ouvertes et segmentées ».
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relachez
le bouton gauche, ceci définit un segment de ligne gradué. Répétez autant de fois que désiré.
Cliquez sur le bouton droit de la souris et le fonctionnement de I'outil se termine. La longueur
de tous les segments de ligne gradués est indiquée a I'extrémité de la régle. Utile pour une
estimation approximative de la circonférence d’'un objet ou d’un patient.

o Outil rapporteur : Dessine un angle sur I'écran et indique la valeur de I'angle en degrés.
Comme un rapporteur.

o Outil regle orthogonale : Crée deux (2) lignes graduées orthogonales ('une par rapport a
l'autre).

Annotations des
utilisateurs
(suite)
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Mode de conception et menu contextuel (clic droit de la souris)  5.7.0

Annotations des
En mode User Annotation Design Mode (Conception d’annotations utilisateur), mais pas dans  ytilisateurs
un mode de fonctionnement spécifique, il est possible de faire un clic droit de la souris pour it
afficher un menu contextuel. Voir ci-dessous. (suite)

Figure 5.7.2

Menu contextuel de la souris
(clic droit) (uniquement en mode
de conception des annotations
de I'utilisateur)

Default Properties Hyperlink...

De nombreux réglages spécifiques peuvent étre effectués a partir de ces menus contextuels.

Notez que si un élément semble trop petit pour étre lu ou vu correctement, vous pouvez
éventuellement le modifier a partir des menus contextuels présentés ci-dessus. Vous pouvez
également choisir de zoomer dans I'image a I'aide de I'outil Dynamic Zoom (Zoom dynamique).
Ceci agrandit 'image et vous devriez pouvoir voir clairement toutes les annotations.

Afficher — masquer les annotations

Le bouton Toggle Annotations (Basculer les annotations) illustré a la Figure 5.7.3, Ic-;igqr € g};m JHid
permet aux utilisateurs d’activer et de désactiver rapidement les annotations. Par AI#I'OZ /I\/C;W lae
défaut, les annotations seront activées. Le bouton est situé dans le menu de droite, (Afficher/Masquer) pour

les annotations de I'utilisateur

prés du coin supérieur droit.
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Le logiciel Vision integre ce manuel sous forme électronique ; il est accessible en format PDF 5 g ()

a partir du menu principal, dans le sous-menu « Help » (Aide).

A propos de l'aide

Le bouton About (A propos de) ouvre une boite de dialogue qui affiche la version du logiciel

Vision, la date de copyright et les informations sur le systeme.

About Vision

H

“Yersion# 3.0.3.1

Yision Yersion 3.1.4 Rewl U (B4-Bit)
Copyright (C) 2005-2018 Faxitron Bioptics LLC

Frocessing Library Information
MName: FEProcessing.dll

——— Camera Library Information
Yersiond 1.0700 Mame: BiCamTLDS.dll

Canfiguration Utility Information
“arsion# 1.2.1.1

———— Camera Infarmation

Make: Teledyne Dalsa, Serial# SERIAL#
Madel: xineos 2923

Sensortype: TDOLS_2304x2944

——— r-Ray System Infarmation
hake: BIOFTICE, hodel: PATHWISION
Firrmware Wersion# PAT01.05

>

5.9.0
A propos du
logiciel Vision

Figure 5.9.1

Boite de dialogue d'informations
About Vision (A propos du logiciel
Vision)
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Conformité
et sécurité

Exigences | Conformité de Faxitron Path+

Limites en émission Exigences de

Le rayonnement émis par I'unité Faxitron Path+ ne dépasse pas une exposition de 0,1 milli- conformité et
Roentgen (mR) par heure en un point quelconque situé a 5 centimétres (cm) a I'extérieur de mesures de
la surface externe. Pour les pays exigeant des valeurs d’émission mesurées a 10 cm des . ie s
surfaces externes, le rayonnement ne dépasse pas 1,0 uSv/h a 10 cm. securite

Verrouillages de sécurité
Le systeme Faxitron Path+ est doté de deux verrous de sécurité situés sur la porte du
compartiment a échantillon.

Bouton de démarrage

Aprés l'interruption de la génération de rayons X par les verrouillages de sécurité, le bouton
Start (Démarrage) du panneau avant reprendra la génération de rayons X lorsque le
systéme sera prét.

Commande par clé

Interrupteur a clé situé sur le panneau avant, qui nécessite d’insérer une clé et de la tourner
dans le sens des aiguilles d'une montre jusqu’a la position « 3 heures » pour mettre sous
tension le systéme de I'armoire. La clé ne peut pas étre retirée en position « MARCHE ».

Bouton d’arrét d’'urgence

Le bouton d’arrét d’'urgence du panneau avant du Faxitron Path+ permet de mettre fin a la
génération de rayons X. C’est un élément supplémentaire qui s’ajoute aux verrouillages de
sécurité des portes du systéeme.

Voyants de génération de rayons X

Le Faxitron Path+ est doté d’'un voyant lumineux d’activation de rayons X sur le panneau
avant et sur l'interface utilisateur graphique ; il émet également un signal sonore pendant la
génération de rayons X.

Puissances nominales
100 V=240 V CA 50/60 Hz 300 W Max.

Normes pour les tests
Tests effectués par Underwriters Labels (UL), laboratoire d’essai américain reconnu au
niveau national et organisme notifié européen.

CEI61010-1:2010 Ed. 3 Exigences de sécurité pour appareils électriques de mesurage, de
régulation et de laboratoire, partie 1 : exigences générales.

CEI 61010-2-091:2012 Ed.1, partie 2-091 : exigences particuliéres pour les équipements a
rayons X montés en armoire.

CEI 61010-2-101:2015 Ed.2, partie 2-101 : prescriptions particuliéres pour les appareils
médicaux de diagnostic in vitro (DIV).

CEI 61326-1 publiée : 2012/07/10 Ed. 2 Matériel électrique de mesure, de commande et de
laboratoire — Exigences relatives a la CEM, partie 1 : exigences générales.

CEI 61326-2-6 publiée : 2012/07/10 Ed. 2.0 partie 2-6 : Prescriptions particuliéres —
Dispositifs médicaux de diagnostic in vitro (DIV).

Marquage CE.

Mandataire de I’UE : Hologic BVBA
Da Vincilaan 5, 1930 Zaventem, Belgique
Tél.: +322 711 46 80 Fax : +32 2 725 20 87

Conforme aux normes de performance de rayonnement du DHHS, 21 CFR, sous-chapitre J.

Conforme aux normes 21 CFR 1040.10 et 1040.11, sauf pour les déviations en vertu de
I’Avis sur les produits laser numéro 50, daté du 24 juin 2007.
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Specimen Radiography System et sécurité
Version DICOM 6.2.0

Norme DICOM

Vision est basé sur la derniére norme DICOM :

ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, version finale,
aoat 1993.

Et est conforme a :

NEMA PS 3.1 — 3.20 (2016), Digital Imaging and Communications In Medicine Set.

Classes de stockage

FAXITRON_DR fournit une conformité standard a la classe DICOM V3.0 SOP suivante en
tant que SCU.

Classe SOP du SCU

Classe SOP UID de la classe SOP
Computed Radiography Image Storage SOP 1.2.840.10008.5.1.4.1.1.1
Digital X-ray Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.1
Digital X-ray Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.1.1
Digital X-ray Mammography Image Storage 1.2.840.10008.5.1.4.1.1.1.2
Presentation

Digital X-ray Mammography Image Storage 1.2.840.10008.5.1.4.1.1.1.2.1
Processing

Study Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.2.1
Patient Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.1.1
Modality Worklist information Model-FIND 1.2.840.10008.5.1.4.31
Greyscale Softcopy Presentation Storage 1.2.840.10008.5.1.4.1.1.11.1

Pour plus de détails, consultez la déclaration de conformité « Full DICOM » enregistrée sur
le systéme. Le fichier se trouve dans C:\Faxitron et un raccourci est fourni sur le bureau.

Si nécessaire, une copie de la déclaration de conformité DICOM est disponible sur demande
aupres de Faxitron.
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Specimen Radiography System

Dépannage

Entretien

Il N’y a pas de piéces réparables dans le systéme. Veuillez contacter votre représentant
Hologic agréé pour toute réparation.

Faxitron Bioptics LLC (une société de Hologic)
3440 E. Britannia Drive, Suite 150
Tucson, AZ 85706, Etats-Unis

Tél. : +1 520 399-8180

Fax : +1 520 399-8182

E-mail : servicedept-faxitron@hologic.com
Site Web : www.faxitron.com

Dépannage

L’ordinateur ou le systéme ne s’allume pas

Pas d’alimentation électrique de I'ordinateur ou du systéme de radiographie.

Vérifiez que le systéme est sous tension (MARCHE) et que les cables d’alimentation sont
branchés et sous tension.

L’état READY (PRET) ne reste pas sur « activé »
Le bouton a été pressé avant que le logiciel Vision ne soit lancé ou avant que le logiciel
n’arme le systéme de radiographie pour une acquisition. Voir Démarrage rapide.

L’image semble indiquer qu’il y a un autre objet dans I'unité de rayons X
Veérifiez que pendant I'étape « Etalonnage », aucun autre objet n'était présent dans I'armoire
a rayons X. Retirez les objets et répétez I'étape Etalonnage.

Mauvaise qualité des images

Vérifiez que les valeurs d’intensité de I'image (I (x,y)) qui se trouvent dans le coin inférieur
droit de la fenétre d’affichage de l'image sont proches de la valeur ADU cible de 8 000.
Si nécessaire, répétez la procédure d’'Imagerie.

Aucun détecteur détecté au démarrage
Il s’écoule jusqua 60 secondes avant que le détecteur Faxitron Path+ soit prét pour
I'acquisition lors du premier démarrage. Essayez de quitter le logiciel et de le redémarrer.

Si cela ne fonctionne pas, essayez de désactiver le pare-feu Windows et vérifiez si le détecteur
est détecté. Si vous avez besoin que le pare-feu soit activé, contactez Faxitron pour la
configuration du détecteur Ethernet afin de lui permettre de communiquer via le pare-feu.

Cybersécurité

Si un événement lié a la cybersécurité se produit, déconnectez le systéme du réseau et
contactez immédiatement Faxitron. Nous travaillerons avec votre département informatique
pour résoudre le probléme.

Un événement lié a la cybersécurité peut étre détecté de plusieurs fagons :

e Fonctionnement et/ou connexion au réseau plus lents que la normale.

e Fenétres contextuelles suspectes ou page d’accueil modifiée dans le navigateur
Internet.

e  Mot(s) de passe inopérant(s).

e Programmes non identifiés dans le menu de démarrage ou dans la barre d’état du
systéeme.

e Données manquantes, corrompues ou altérées.

Le Faxitron Path+ peut fonctionner sans ordinateur et sans détecteur numérique si
l'installation dispose de films radiologiques ou de plaques CR. Lorsque l'ordinateur est mis
hors tension, le systéme fonctionne en mode manuel, dans lequel les valeurs kV et mA sont
réglées a l'aide du petit écran tactile du systéme. Placez le film radiologique a I'intérieur de la
chambre, placez I'échantillon dessus, puis exposez le film ou la plaqgue CR aux rayons X.
Vous devrez peut-étre faire appel a un radiologue pour régler I'exposition correcte.

Entretien et
dépannage
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SECTION

Calendrier de
maintenance

Ce document fournit un calendrier de tests et de maintenance pour le Faxitron Path+. Il est
fortement recommandé que I'entretien et les tests décrits dans cette section soient effectués
en respectant les intervalles de temps indiqués, pour s’assurer que votre générateur de
rayons X continue a fonctionner avec des performances optimales.

8.0.0
Maintenance

Avertissement : Les échantillons contenant des tissus peuvent abriter des 8.1.0

agents infectieux dangereux pour votre santé. Respectez les procédures de Intern

biosécurité appropriées ; portez des gants lors de la manipulation des erne

échantillons de tissus ou des matériaux avec lesquels ils sont entrés en contact.

Essuyez lintérieur de I'armoire avec de [l'alcool isopropylique a 70-90 % ou avec de

I'hypochlorite de sodium dilué (5,25-6,15 % d’eau de Javel domestique diluée a 1:500 fournit

la concentration appropriée). Veillez a ce que la zone de I'échantillon, indiquée sur le sol de

la chambre, soit nettoyée a fond.

N’utilisez PAS les produits suivants sur la fenétre de la porte du compartiment a échantillon :

¢ Alcool isopropylique.

o Acétone.

Essuyez le systéme avec un chiffon humidifié avec de I'eau et du savon doux. Aucun abrasif 8 2 ()

ou nettoyant agressif ne doit étre utilisé sur le systéme, pour éviter les rayures. Ne laissez Extern

pas I'humidité entrer en contact avec les composants électriques de l'unité. erne

Détecteur

1070-7003DETECTEUR PKE XRPAD 4343 F. 8.3.0
Piéces

Systéme informatique

2001-0021 CARTE ETHERNET D’ORDINATEUR, DELL.

2001-0022 ORDINATEUR, CARTE GRAPHIQUE GEFORCE GT 730.

2001-0024 ORDINATEUR, 64 BIT DELL OPTIPLEX XE2.

2009-0026 MONITEUR, DELL 27 UHD, U2718Q.

2013-0018 SOURIS, OPTIQUE, BLANCHE MICROSOFT.

2013-0027 CLAVIER, USA, KSI-U10020-US-HOL-2 (pour les autres langues, contactez Hologic).

Contréleur .
2001-0034 ECRAN TACTILE, 7 POUCES, LCD.
43805-65335 ENS. Cl, CARTE CONTROLEUR.

Tube a rayons X et alimentation HT.
130-552027TUBE, MICROFOCUS,100 KV MXR.
131-10024 HVPS, 100 KV GAMMA, MXR & TRUFOCUS.

Alimentation basse tension o
131-20010 ALIMENTATION A DECOUPAGE ASTEC LPQ252-C.

Verrouillage de la porte
3101-1989ENS. VERINS, COMMUTATEUR DE VERROUILLAGE.
3101-1990ENS. BOITIER COMMUTATEUR, VERROUILLAGE.

Pour les autres éléments, contactez Faxitron/Hologic.

remplagables

e Fantdme ACR (Nuclear Associates Réf. 18-250).
e Radiameétre pour chambre d’ionisation, Inovision Modéle 451B-DE-SI-RYR ou similaire.
¢ Bidon d’eau en plastique de 1 gallon (4 litres).

§.4.0
Equipement
nécessaire
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Les composants logiciels suivants sont obligatoires pour le systéme :

Logiciel Vision. Informations de

Bibliotheque de traitement Faxitron. référence
Bibliotheque BiCam.

Utilitaire de démarrage automatique.

Facultatif :

Utilitaire d’étalonnage.

Les définitions suivantes s’appliquent aux termes énumérés ci-dessous lorsqu’ils sont
mentionnés dans le présent calendrier de maintenance :

Définitions
ADU : Analog-to-Digital Units (Unités analogiques-numériques).

AEC : Automatic Exposure Control (Controle automatique de I'exposition) — L’ordinateur met

fin aux rayons X lorsque suffisamment de signal a atteint le détecteur.

Agrandissement : Eloignement de I'objet du détecteur et rapprochement de la source de
rayons X pour agrandir I'image de I'objet sur le détecteur.

Bruit de lecture : Mesure du bruit RMS pendant une exposition sombre de 0 seconde (pas
de signal).

Champ plat : Corrections de gain et de décalage effectuées pixel par pixel. Chaque pixel a
un gain et un décalage différents et doit étre étalonné.

Contraste : Pourcentage de différence entre l'intensité de I'objet et I'intensité de I'arriere-plan.

Courant d’obscurité : Signal généré thermiquement dans le capteur; (presque) linéaire
dans le temps.

Fantome ACR : Fantdme d’accréditation de I’American College of Radiology.

MTF : Modulation Transfer Function (Fonction de transfert de modulation). Mesure du
contraste et de la résolution d’un systéeme d’imagerie.

Paires de lignes par millimétre : Nombre d’éléments de plomb et d’air alternés. Par
exemple, 10 Ip/mm signifie => {air/plomb} {air/plomb} ... 10 fois par millimétre.

Radiographie d’échantillons : Imagerie radiographique d’un morceau de tissu aprés son
extraction du corps.

ROI : Region Of Interest (Région d'intérét). Généralement une sous-région spécifique d’'une image.

SID : Source-to-image distance (Distance source-image) ; distance entre la source de rayons X
et le détecteur.

Le systéme doit étre entretenu au moins une fois par an. Des intervalles plus réduits pour
les contréles de rayonnement et les tests d'image peuvent étre appliqués par I'utilisateur, Maintenance
conformément aux instructions de ce manuel. Reportez-vous aux réglementations locales et % P

! e . . o réguliére
aux procédures de I'établissement pour plus de conseils et pour les questions de conformité.

Un contréle radiologique doit étre effectué chaque fois que le systéme est déplacé ou
endommageé.

Cybersécurité
Toute mise a jour de logiciel ou de micrologiciel effectuée depuis la maintenance précédente
et qui résout un probléme de sécurité ou de sireté peut étre fournie si nécessaire.

Le micrologiciel est codé en dur dans la carte de commande, donc si une mise a jour du
micrologiciel est nécessaire, remplacez la carte de commande du panneau de commande.
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Verrouillages, voyants, messages d’erreur
Imprimez cette page pour I'utiliser comme documentation de test si nécessaire.

Consignez les résultats dans la rubrique « Verrouillages et indicateurs de sécurité » du registre
de maintenance périodique, situé a la fin de la section, ou dans un formulaire approuvé.

1. Le systeme doit étre sous tension. L’interrupteur a clé doit étre en position « 3 heures » et
la clé doit étre impossible a retirer.

2. Assurez-vous que le voyant vert « Power » (Alimentation) s’allume et qu’aucun autre
voyant n’est allumé a ce moment-la.

3. Assurez-vous que I'écran LCD s’allume et affiche « System Idle » (Systeme inactif) et qu’il
n’y a pas d’autre message, tels que « Door Open » (Porte ouverte) a ce moment-la.

4. Ouvrez la porte du compartiment a échantillon. L’écran LCD affiche le message « Door
Open » (Porte ouverte). Lorsque la porte est refermée, ce message doit disparaitre.

5. Si le logiciel n’a pas encore démarré, double-cliquez sur l'icdne Vision. Si cela déclenche
un étalonnage, laissez-le s’achever complétement.

6. Ensuite, cliquez sur le bouton Start Procedure (Démarrer la procédure), puis sur le bouton
Patient Data (Données du patient) et choisissez le bouton Enter Manually (Entrer
manuellement) pour accéder a I'écran de saisie du patient. Remplissez tous les champs
marqués d’un astérisque (*) et cliquez sur le bouton Start (Démarrer). Cela permettra de faire
une exposition.

7. Vérifiez que le voyant vert « Ready » (Prét) est allumé.

8. Appuyez sur la touche verte « X-ray » (Rayons X) de I'écran tactile situé a l'avant du
Faxitron Path+. Le systeme devrait débuter une exposition aux rayons X. Assurez-vous que

e L’écran tactile LCD affiche « X-Ray On » (Rayons X activés) et qu’il affiche le kV et

le temps corrects.

e Le logiciel affiche « X-Ray On » (Rayons X activés) (coin inférieur droit)

e Un niveau sonore est audible pendant toute I'exposition

e Le voyant rouge « X-Ray On » (Rayons X activés) s’allume.
Laissez I'exposition s’achever et assurez-vous que I'image s’affiche sur I'écran de I'ordinateur.

9. Appuyez a nouveau sur le bouton vert pour démarrer une autre exposition. Pendant
I'exposition, appuyez sur le bouton rouge « Stop » (Stop) : normalement, le rayonnement doit
s’arréter dans les 2 secondes suivant la pression sur le bouton. Le signal sonore cessera
notamment de retentir pour indiquer que I'exposition a été arrétée. Le logiciel affichera des
erreurs d’interruption, ce qui est normal. Les erreurs peuvent étre effacées, ce qui permet de
reprendre la génération de rayons X.

10. Répétez ce test en utilisant le bouton d’arrét des rayons X.
11. Appuyez a nouveau sur le bouton vert et laissez le rayonnement démarrer. Cette fois,

ouvrez la porte du compartiment a échantillon ; ceci devrait déverrouiller les interrupteurs de
sécurité et forcer I'arrét du rayonnement. Le logiciel peut afficher des erreurs, acquittez-les.

Verrouillages et
indicateurs de
sécurité
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Fantéme ACR (insert en cire uniquement)

Remarque : D’autres fantdbmes de test peuvent étre utilisés. Contactez Faxitron/Hologic pour
plus de conseils.

Consignez les résultats dans la rubrique « Test Fantdbme ACR » dans le registre de
maintenance périodique, situé a la fin de la section ou dans un formulaire approuvé.

L'utilisateur doit étre familiarisé avec I'utilisation du Faxitron Path+ et doit connaitre les
procédures de prise de radiographies. Achevez les procédures de configuration et assurez-
vous que le détecteur est étalonné (notez le kV et la durée d’étalonnage), saisissez les
données du patient et prenez une image de la partie de l'insert en cire du mini fantome ACR
avec un agrandissement x2. L'insert en cire doit étre retiré de son support en acrylique.

Le mini fantdbme ACR contient 12 objets : 4 masses, 4 fibres et 4 groupes de calcifications
(taches). Chaque groupe de calcification contient 6 calcifications ou taches individuelles.

Toutes les masses, fibres et calcifications doivent étre visibles.
CRITERES D’ACCEPTATION
1. Configurez le systéme pour prendre une image manuelle de l'insert en cire du mini

fantdbme ACR. Réglez les kV et la durée sur ceux notés lors de I'étalonnage.

2. Assurez-vous que le fantdbme est propre et exempt de tout débris.

3. Placez I'insert de cire directement sur le sol de la chambre au milieu de la zone d’imagerie.
N’utilisez pas de bloc d’atténuation.

4. Démarrez I'exposition aux rayons X, attendez que tous les traitements soient achevés et
que l'image soit affichée.

5. Tous les objets du fantdbme peuvent ne pas étre visibles lorsque I'image est affichée pour
la premiére fois. Ajustez les niveaux de contraste et de luminosité selon vos besoins pour
obtenir une meilleure image.

6. Une fois 'image corrigée, tous les groupes d’objets doivent étre visibles.

7. Consignez les résultats dans le registre de maintenance périodique.

Test du
fantome ACR

Figure 8.6

Image radiographique typique du
mini fantéme ACR (insert en cire
uniquement)

Figure 8.7

Image radiographique de l'insert
de cire du mini fantéme ACR
(Nuclear Associates Réf. 18-250).
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Contréle du rayonnement

Le fabricant recommande qu’un contréle radiographique soit effectué au moins une fois par an
pour s’assurer qu’il n’y a pas d’émission de rayonnement excessive. Si la machine est déplacée
ou endommagée d’'une quelque fagon aprés son installation, alors le contréle radiographique
doit étre effectué avant de remettre la machine en service dans I'établissement.

Consignez les résultats dans « Controle du rayonnement » dans le registre de maintenance
périodique, situé a la fin de la section ou dans un formulaire approuvé.

Outils nécessaires

e Radiamétre pour chambre d’ionisation, offrant une précision adaptée a la valeur kVp
maximum et au spectre du faisceau de I'unité de rayons X examinée.
¢ Bidon d’eau en plastique de 4 litres (1 gallon).

Vérification du fonctionnement du radiamétre

1. Date d’étalonnage : Assurez-vous que I'étalonnage du radiamétre est a jour.

2. Vérification de la batterie : Vérifiez I'état de la batterie. Remplacez les batteries avant le
contréle du rayonnement, si nécessaire.

3. Vérification du fonctionnement : (Si la source de contréle est disponible)

Remarque : Les étapes suivantes s’appliquent a Inovision 451B ou a des radiameétres pour
chambres d’ionisation similaires. Suivez les instructions des fabricants pour les autres
radiametres.

¢ Ouvrez le blindage coulissant contre les rayons béta situé au bas du radiamétre.
e Réglez le radiamétre sur la source de controle et surveillez pendant 30 secondes.

e Le radiametre doit donner des valeurs dans les limites de tolérance indiquées sur
I'étiquette d’étalonnage.

« Consignez les mesures dans le registre de maintenance périodique.

e Refermez le blindage contre les rayons béta du radiameétre.

Remarques importantes

1. Toutes les mesures de rayonnement sont effectuées avec le radiamétre & moins de 5 cm
(2 po) de la surface du Faxitron Path+.

2. Lors de l'enregistrement des mesures de rayonnement, il peut étre nécessaire de les
multiplier par 0,1 pour convertir la lecture de uSv/h en mR/h. Par exemple, 12 uSv/h est égal
a 1,2 mR/h.

8.8.2
Contréle du
rayonnement
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Procédure de contréle du rayonnement

1. Relevez une valeur du rayonnement de fond (pointez I'appareil de mesure vers le centre de
la piéce) et enregistrez la valeur (consignez les unités utilisées dans le registre/formulaire).

2. Effectuez un étalonnage complet, y compris un préchauffage complet du systéme.
3. Sur I'écran tactile du Faxitron Path+, mettez le systéme en mode manuel.

Remarque : Vous pouvez éteindre I'ordinateur en utilisant le bouton d’arrét du logiciel dans
Vision, mais laissez la clé en position MARCHE. Ceci permet au systéme de générer des
rayons X sans acquisition d’image, ce qui accélére le processus, mais vous pouvez
également le faire en mode d’acquisition numeérique (PC en marche).

4. Ouvrez la porte du compartiment a échantillon. Placez le bidon d’eau en plastique de
4 litres (1 gallon) au sol dans la zone d’'imagerie de la chambre et fermez la porte.

5. Appuyez sur la touche « START » (DEMARRER) et relevez les émissions de rayonnement
au sommet, a 'avant, a I'arriére et sur les deux cotés de I'armoire. Balayez lentement toutes
les surfaces avec le radiameétre. Il faut normalement compter 1 & 2 expositions aux rayons X
pour chaque balayage. Remarque : Vous devrez lancer plusieurs fois les émissions de rayons
X pour effectuer le contréle du rayonnement dans son intégralité.

6. Consignez les valeurs pour chaque emplacement de test.

7. Si 'une des valeurs est supérieure a la limite d’émission de rayonnement du Faxitron a
hauteur de 0,1 milli-Roentgen (mR) par heure (1,0 uSv/h) en un point quelconque situé a
5 centimétres (cm) a l'extérieur de la surface externe (*), contactez un représentant de
Faxitron ou de Hologic pour discuter des options de réparation.

(*) 0,5 mR/h @ 5 cm des surfaces externes est la limite supérieure fixée par le CDRH
de la FDA américaine pour les équipements a rayons X montés en armoire. Si
I'appareil est utilisé dans un autre pays, veuillez vérifier les limites officielles du pays
pour les équipements a rayons X montés en armoire utilisés a des fins de diagnostic
in vitro.

Pour certains pays, les points de test doivent étre & 10 cm des surfaces externes et
dans ce cas, I'émission de rayonnement du Faxitron doit étre inférieure a 0,1 mR/h a
10 cm des surfaces externes.

8. Retirez le bidon d’eau de la chambre a rayons X.
9. Le sol de I'armoire de radiographie doit étre analysé de nouveau sans le bidon d’eau.

Vérifiez qu’il n’y a rien dans la chambre a rayons X, lancez une radiographie et balayez le
fond de I'armoire. Enregistrez les mesures.

Controdle du
rayonnement
(suite)
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Calendrier de
maintenance

Fiche de maintenance périodique — Faxitron Path+

N° Série du systéeme : N° Série de la caméra :

Verrouillages et indicateurs de sécurité — Conformément a la section 8.8.0

Réussite : Echec : Initiales : Date :

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec.

Initiales : Date :

Test avec fantome ACR — Conformément a la section 8.8.1
Nombre d’objets observés : Masses : Fibres : Groupes de calcification :

Réussite : Echec : Initiales : Date :

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec.

Initiales : Date :

Controle du rayonnement — Conformément a la section 8.8.2

Lectures du

rayonnement en : D mR/h D puSv/h  Sourcedecontréle: _ Arriére-plan:
Avant: Coté droit : Dessus :

Arriere: Coté gauche : Dessous :

Réussite: Echec: Initiales : Date :

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec.

Initiales : Date :

La maintenance périodique susmentionnée a été effectuée par :

Date de I'exécution : Signature :
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SECTION 9
Historique des révisions

FAXITRON PATH+ MANUEL DE L’UTILISATEUR | HOLOGIC | REVISION 001 HOLOGIC®



Faxitron” Patht

Specimen Radiography System

SECTION

Historique
des révisions

Description de la

Version Date modification Auteur/Initiateur | Approuvé par
Ebauche 1.0 1-mai-2018 Ebauche d’ingénierie initiale Joseph Mudd Ciaran Purdy
Ebauche 1.1 | 11-octobre-2018 | Ajout des spécifications relatives Ciaran Purdy Ciaran Purdy

au détecteur, du représentant
dans I'UE et mise a jour de
I'étiquette du code-barres
Ebauche 1.2 | 27-janvier-2019 | Ajout de la détection Ciaran Purdy Ciaran Purdy
d’événements de cybersécurité
(7-2)
Ajout des descriptions et du
tableau des connexions
interopérables (2-2)
Ebauche 1.3 11-mars-2019 | Ajout de la version DICOM et des | Ciaran Purdy Ciaran Purdy
classes de stockage a la
Section 6
Rév. 001 26-ao0t-2019 Mise a jour des marques et Ciaran Purdy S. Howerton
lancement de la production J. Mudd
Modification de certgines sections D. Canny
pour les rendre cohérentes avec )
celles d’autres manuels D. Saraiya
R. Nash
T. Longo
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